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Dear Children,

The ICT Text book of Class VIII must have made studying

different subjects interesting and easy for you. The text book for ICT

education in Class IX this year has been prepared with an objective

of helping you in studying different subjects and in conducting

related activities using computer and Internet. This text book will tell

you how to make a collage, which is part of your classroom

activities, using GIMP software. It will tell you how to make tables

and charts using spreadsheet application. Constructing

geometrical shapes, and measuring their area and perimeter are

included as well. You will also learn to construct a web page and the

ways to enrich it by adding images and pictures. Operating

systems are fundamental to the working of computers. This text book

deals with operating systems in good detail with an intention to

provide you a clear understanding of their role. This textbook has

activities in chemistry that would help you to look at periodic table,

electronic configuration of elements, and properties of elements

from a more interesting perspective. It also has a chapter that would

guide you in making short films using scripts that you write as part

of your language course. This textbook will also familiarise you with

online portals such as PhET which are large pools of digital

learning resources. You will also understand the basics of computer

programming. You must  take earnest interest in using the

computer lab in your school to practice the activities given in this

text book. I am sure such exercises will contribute effectively

towards your future learning.

Wishing success to all of you,

Prof. M. A. Khader
Director

SCERT, Thiruvananthapuram
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CONSTITUTION OF INDIA
Part. IV A

FUNDAMENTAL DUTIES OF CITIZENS

       ARTICLE 51 A

       Fundamental Duties - It shall be the duty of every citizen of India :

(a) to abide by the Constitution and respect its ideals and institutions,
the National Flag and the National Anthem ;

(b) to cherish and follow the noble ideals which inspired our national
struggle for freedom ;

(c) to uphold and protect the sovereignty, unity and integrity of India ;

(d) to defend the country and render national service when called upon
to do so ;

(e) to promote harmony and the spirit of common brotherhood amongst
all the people of India transcending religious, linguistic and regional
or sectional diversities ; to renounce practice derogatory to the
dignity of women ;

(f) to value and preserve the rich heritage of our composite culture ;

(g) to protect and improve the natural environment including forests,
lakes, rivers and wild life and to have compassion for living
creatures ;

(h) to develop the scientific temper, humanism and the spirit of enquiry
and reform ;

(i) to safeguard public property and to abjure violence ;

(j) to strive towards excellence in all spheres of individual and
collective activity so that the nation constantly rises to higher levels
of endeavour and achievement.

(k) who is a parent or guardian to provide opportunities for education
to his child or, as the case may be,  ward between age of six and
fourteen years.
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1 This Colourful World

The beauty of the earth is its
biodiversity consisting of plants, birds,
animals, rivers, forests, and even
deserts. Still our environment today is
on the verge of collapse. The
biodiversity is getting degraded day by
day due to the short-sighted actions of
humans. Have you ever heard these
lines Dr. Aiyappa Panikkar, the
celebrated Malayalam poet had
written?

“O dear children, where are the forests?
Where are the hillocks?
Where are the roots of the wild meadows?
Where is the coolness of the wild streams?
Where are the flowery groves that have
winds immersed in them?”

This poem is a work of art that
makes us aware of the ongoing
destruction of the environment. We can
also do certain things in order to build
awareness among people about the
destruction of  the environment and the
fall in biodiversity. Figure 1.1 is a
collage made by the students of a high
school in Wayanad for an awareness
building campaign in connection with

the observation of 2010 as Biodiversity
Year. Do you think this collage helps in
depicting the richness of our
biodiversity? Shall we also prepare a
collage for an awareness building
exercise like this?

Do you know how to make a
collage? Collage is the art of creating a
new visual experience by cutting and
joining pictures, pieces of news reports,
paintings and several other things
together. It is very easy to make a
collage with the help of a computer.

Pic. 1.1
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Collage Using Computer

In the eighth standard, you had
learned about software applications
that help us draw pictures. GIMP is a
software that helps in drawing pictures.
We can create a collage using GIMP. Let
us see how this is done.

In order to build a collage, we need
to have the required pictures with us.
Similarly, for creating a collage on a
computer, we need to store those
pictures in the computer. In this case,
what we need are pictures that depict
biodiversity. We can download such
pictures from the Internet. Don’t you
remember the way to download files
from the Internet? Don’t forget to save
the pictures that you download in your
folder. You can also scan the pictures
you already have and save them in your
folder. You can also take photographs
and transfer the images from the
camera to the computer.

You may not use all the pictures
that you have in a collage. You may use
only parts of the pictures for a collage.
Based on the given indications, discuss
the parts of the pictures that you would
like to include in your collage, and
prepare to make it.

Indications

� Do we need to include all the por-
tions of the pictures in the collage?

� Are all the pictures used of the same
size?

� ..............................................................

� ..............................................................

� ..............................................................

� ..............................................................

Opening pictures using GIMP

The first step is to open the pictures
and images that you have collected
using GIMP. You know how to open
GIMP software by selecting menu bars
and clicking in the following order:

Applications →→→→→ Graphics →→→→→ GIMP →→→→→
Image Editor

You can open the image using
GIMP by selecting ‘File’ in the menu bar
of GIMP Image Window and clicking
‘Open’ (Pic. 1.2). Is there any other way
to do this? Why don’t you try?

When you manipulate an image
opened thus, its natural shape may
change. Why is it so? What can we do

Pic. 1.2

GIMP

It was Peter Matis and Spencer
Kimbal, two students at the
University of California that designed the
original version of GIMP. GIMP can be
used as a simple painting software, as a high
end image editing software, and as image
format converter. GIMP was the first free
image manipulation tool. Now a days
GIMP software that works on Windows
and Mac in addition to Linux operating
system are also available.
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about it? Discuss among yourselves and
resolve it. If required, you may ask your
teacher for help.

Parts of Pictures on to the Canvas

The next step is to paste the parts
of the pictures on to the new canvas. Try
writing the steps for that. You had
learned the steps for opening a canvas.
Read the note and try opening a canvas
of required size (Pic.1.4).

Colouring the Canvas

Let us now paint the canvas with a
background colour. In order to do this,

click the  icon in the tool box and
select the colour of your choice. Then
click the  icon, move the mouse
pointer inside the canvas and click. See
how quickly the canvas has got a new
colour. Try different colours and select
the best-suited colour.

Adding Pictures to the Canvas

Select the pictures that you have
opened using GIMP and stick them on
the canvas using selection tools such as
‘Rectangle’, ‘Elliptical’, ‘Free Selection’,
etc. How do we use the different

selection tools? Try using the given
study notes.

Layers of the Picture

Try moving the picture that you
have stuck on the canvas using ‘Move’
tool. Are you able to move the picture?
Click the mouse once outside the
canvas in the picture area and use
‘Move’ tool again. What happens? Why
are you not able to move the picture
using ‘Move’ tool? Discuss and
conclude based on the indications and
notes.

Stick all the parts of the collected
pictures that you have cut and kept for
making a collage. Don’t forget to save
every piece of work.

Indications for Discussions

� What is the reason why pictures
could not be shifted using ‘Move’
tool in both the activities?

We can take the copy of an image by
selecting ‘Image’ option in GIMP
image window and clicking on
‘Duplicate’. We can keep the copy
open on screen and close the original
image.

Pic. 1.3

Click on ‘New’ in the ‘File’ menu in the
GIMP image window. Provide the required
width and height in the ‘Image size’ option
inside the “Create a new image’ dialogue
box. You may press ‘OK’ button to generate
a new canvas. Another way to open a new
canvas is to select the template of our choice
from the ‘Template List’. The size of an
image is usually determined in ‘Pixels’.
Pixel is the smallest unit for specifying an
image

Pic. 1.4
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� Was it because they got so closely
stuck with the canvas?

� ..............................................................

� ..............................................................

� ..............................................................

Let’s Make the Collage Attractive

Pasting pieces of pictures on a
canvas won’t make a collage. The pieces
should merge seamlessly into a new
whole picture. How is that possible?
Analyse the given study note and plan
the action which would make the pieces
of pictures on the canvas look like a
single image.

Now that you have used different
‘Transform tools’ to make the collage
more attractive, don’t you realise that if
we merge the edges of the pieces, they
would all look part of a single picture?
For this click the  icon in the tool box.

Selection Tools

Selection tools help us to select a specific area of an image or layer
(Pic.1.5). Let’s familiarise ourselves with a few selection tools.

Rectangle Tools

This tool is used to select a part of an image in square shape. This
can be done either by clicking

‘Rectangle tool’ under ‘Select tools’ in the ‘Tools’ menu, or by
clicking the  icon in the tool box.

Elliptical Tool

This tool is used to select a portion of a picture in circular or
elliptical shape. You can select the tool either by clicking in the
following order Tools →  Selection Tools → Ellipse or by

clicking on  icon in the tool box.

Free Selection

This is a tool used to select a portion of the picture in any shape that we like. Either click in
the order  Tools → → → → →  Selection Tools → → → → →  Free Select or select   icon in the tool box to
activate this.

Pic. 1.5

LAYER
Layers make one of the important features
of GIMP software. These transparent
layers get arranged one over the other on
the canvas. After copying and before
pasting selected pictures, click on ‘New
Layer’ on the canvas (Fig 1.6). This creates
a layer which is of the same size as the open
canvas. Then click in the following order:
Edit ’! Paste. The pictures or layers copied
earlier get pasted on the canvas

Pic. 1.6



This Colourful World

� 11

Layer Palette
Click on Layers (Fig 1.7) in Dockable
Dialogues in the Windows menu of the
canvas. All the layers that we have created
so far will be displayed. Either by clicking
the Down arrow in the portion called
Mode, or by moving the slider in the portion
Opacity, you can change the properties of
the layer. By clicking on the ‘eye’ icon, you
can hide and again display the layer

Pic. 1.7

Smudge Tool
Smudge is a pint tool which helps you to
merge the various colours in the selected
layer. In order to activate the smudge tool,
click in the following order: Tools     →
Paint Tools → Smudge.  Click on the
selected image after activating the tool.

Scale Tool

Scale tool in GIMP is used for
changing the size of of the layer, the selected
area, and the picture. Scale tool can be
activated either by clicking in the order
Tools →  Transform  Tools → Scale in
the canvas or by clicking on the  icon.
Once scale tool is activated, click on the
picture of the layer. In the dialogue box that
appears, make required changes in Width
and Height, and click on Scale (Fig 1.9).
You can see the size of the picture
changing according to the values that you
have assigned

Transform Tool

Transform tools help us make
changes in the shape and size of
pictures. You can activate them either
by clicking on the tools menu, or by
clicking on the corresponding icons
in the tool box (Fig 1.8).

Pic. 1.9

Rotate Tool

Rotate tool is used for tilting the layer,
a selected portion, or a picture in a required
angle. You can activate this either by

Pic. 1.8
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Flip Tool

Flip tool helps you to turn a picture
over either towards left or towards right.
Click  Tools →  Transform  Tools → Flip.

Another way is to click    icon in the
tool box. After activating Flip tool, click on
the picture to be flipped.

clicking. Tools →  Transform  Tools →
Rotate by clicking on the  Then, click
on the picture or the layer to be tilted. Make
the required changes in the dialogue box
that appears and click Rotate (Pic.1.10).

Pic. 1.10

And try to make the collage more
attractive using the ‘Clone tool’ that you
had learned in the last class.

���

Save the collage that you have
made in different image formats and
note down the differences across them
in your IT Notebook. Conduct a digital
collage demonstration in the IT lab
using the various pieces of collage
made in your class.

Follow up activities

1. Use GIMP software to create a
collage on the health and social
problems caused by alcoholism,
smoking, and chewing pan masala
as explained in the chapter ‘Protect-
ing Life’ in your biology text book.

2. Use GIMP software to make a poster
on ‘the magic world of carbon’ based
on the Unit 12 of the physical science
text book.

3. Prepare a poster in GIMP relating to
the story titled ‘Amma with Love’ in
Malayalam textbook.

4. Create a collage that depicts Kerala’s
cultural diversity.
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2 Data Collection and Analysis

What you see below is the news
report of a study conducted by the
World Health Organisation (WHO) on
the state of health of the world’s
children.

The World Health Organisation
remarks that staying away from games
is problematic. The report has been
prepared after analysing children’s food
habits, exercise habits, games that they
play, their height, weight and so on.
This report covers children across
several countries. The study found that
only 15% of the world’s children do

sufficient exercises. This means only
15% of the world’s children enjoy proper
health.

What about the children in our
school? Are all of them healthy? Shall
we conduct a study similar to the one
that WHO did? As part of the activities
of the school health club, let us conduct
a survey and analyse the results.

How do we conduct such a study?
Will it suffice to ask children whether
they play everyday? In order to conduct
a proper study, we have to use

appropriate meth-
odology.  We will
have to decide on
what all we want to
know, where do we
collect information,
and how. There are
various ways of
collecting informa-
tion including
administering a
questionnaire or
data collection
formats.
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Children in a school in Thiruvananthapuram district had
conducted a similar study using a data collection format that they developed,
which is shown in Table. 2.1.

Let us make a similar format for our
study and use it for data collection.
Take adequate number of copies with
your teacher’s help, distribute them
among the students in the class and
request them to fill up.

Those children used the software
called Open Office Calc for data entry

and analysis. Calc is an open source
spreadsheet which helps us to consoli-
date and analyse data.

They conducted the study by
collecting data from 40 students from
different classes. See the tabulation of
their data in Table 2.2.

Table. 2.2

Table. 2.1
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Table 2.3

Let us now try to arrange the data
that you have collected in a similar way.
Spread sheet applications are made of
rows and columns. Do you find any
problem in figuring out the data in the
last row and column? How can we
overcome this? Discuss among
yourselves and find out.

Freezing Rows and Columns

Suppose you were doing this
tabulation on sheets of paper. You
cannot enter all the data on a single
sheet. Therefore you will have to write
down the names of the students and the
types of information collected such as
age, food habits etc., on each page
before entering the data. Or let us say
you have to repeat the ‘titles’ on each
sheet that you use.

But in a spreadsheet you have an
easier way to handle data that spreads
much beyond the size of a computer
screen. The function for this is called
‘freezing’. As the word indicates, we
freeze or fix the title rows and columns

permanently so that we can see them
even while scrolling much beyond the
computer screen.

Now let us see how we can freeze
the column that includes the names of
students (Column B) and the title row
(Row 3). As shown in Table. 2.3, click
on the highlighted cell. Then press
‘freeze’ on the window menu in the
menu bar. Now move the rows and
columns using scroll bar. Explain what
you notice.

Selecting and Sorting Data

Calc software has tools that allow
you to arrange the data that you have
tabulated in different ways and to
select data that match certain criteria.
Filter is a tool that helps you to select a
set of data that match some specific
criteria.

Let us see how you can filter out
information pertaining to girls alone
(Criterion: The respondent student
should be a girl).
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Table. 2.5

Select the title row of the tabulation,
and go to menu bar. Select Data, and
then select Filter, and finally Auto
Filter. What is the difference you see in
the selected row? Explain. In order to
select pertaining to girls alone, click on
the arrow near the title cell that shows
Boy/Girl. Select ‘Girl’ from the list that
appears (Table 2.4).

When you filter out the data
regarding girls, the rest of the data
disappears from the screen. (Table2.5)
You can copy the filtered data and save
it as a different file. Similarly use ‘filter’
to select the data pertaining to boys and
save it as a separate file.

Use ‘filter’ to do the following
operations.

Table 2.4
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Pic. 2.1

� Select the data relating to students
from Class IX alone and save it as a
file.

� Prepare a list of vegetarians among
the students in the table.

Functions

A function is a pre-set formula that
helps us do an operation quickly. Calc
has several functions for various
operations. COUNTIF is a function that
finds out the number of cells that
contain a specified value. The value can
be absolute or relative (greater than, less
than). ROUND is a function used to
specify the required number of decimal
places. Other commonly used functions
include POWER for exponentiation,
SUM for addition, AVERAGE etc. You
can see various functions by selecting
Function in the Insert menu.

The first step towards activating a
function is to click in the cell where you
want the result to be. Then the data set
on which the function has to be
operated upon has to be selected. Can

SUM Function

SUM function is used to summarise
the data in rows or columns. When you
operate the SUM function, you have to
specify the data range within which you
want to operate the function in the formula
window. You can do this by selecting rows
or columns.

you figure out the way to operate ‘SUM’
function by opening the function
window?

Try operating different functions in
Open Office Calc. You may find several
unfamiliar functions in it. You will learn
them in higher classes.

Which function will help you to list
out the vegetarian students in our data
table?

COUNTIF is a function which can
be used for similar operations. Try the
function. Find out the information to be
provided for operating the function.

Range : ..............................................

Criteria : What information is to be

looked for

Now select the cell where you want
the number of vegetarian children to
appear and operate COUNTIF function.
When you select the data range and
click OK, you get the actual count in the
cell that you had selected.

You may use the same function to
find out several other information
needed to draw conclusions from the
study.

Now let us calculate the Body Mass
Index (BMI) of the children covered
under the study. Based on BMI, you can
find those who are of normal weight,
underweight, overweight, or obese.

Now, make necessary arrange-
ments in the data table with your
teacher’s support and calculate the BMI
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Body Mass Index (BMI) is an index used for studying people’s health status. BMI
shows the right weight a person should have for a given height.

BMI – Analysis Table

Below 18.4 - Under Weight

18.5 to  24.9 - Normal Weight

25 to  29.9 - Over Weight

Above 30 - Obestiy

1. COUNTIF is a function to count the number of cells that contain a particular value.
You can get the count by specifying the data range (eg: A2:A40 or A2:B40), and the
value to be looked for (eg: “YES”, “NO”,2,), or the address of the cell that contains
the value (A12 or B23).

            COUNTIF (A2:A200;”YES”), OR

            = COUNTIF (A2:A200;C12),

            OR

COUNTIF (A2:A200;3)

2. POWER helps in exponentiation of numbers. For example, if you want to find 2 to
the power of 4, you can find it by simply typing POWER (2;4). Instead of 2, and 4,
you can also execute the function by providing the addresses of the cells that contain
2 and 4).

3. ROUND helps in fixing the decimal places. For example, if you want to round 3.1487
two decimal places, you may use ROUND (3.1487;2) or ROUND (A1;B1) where
A1 and B1 are the cell addresses of 3.1487 and 2 respectively.

for all the children. Find those who are
underweight or obese, and relate their
life styles and food habits with their
health. Prepare a report based on your
findings. Use Open Office Writer to type
in the report.

Making Reports Impressive

In order to make a report look im-
pressive, you have to pay attention to

Weight (In Kilograms)
Height2 (In metre)

BMI   =

details. Pic 2.2 shows a page from a text
book.

Observe the page lay out. Compare
the lay out and design of different books
and reports and evaluate them.

� Titles should be of common size

� Sub titles should be of the same
pattern
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� ..............................................................

� ..............................................................

� ..............................................................

� ..............................................................

� ..............................................................

Open Office Writer has a facility
called ‘Style’ that helps you provide
impressive lay outs to reports running
into several pages.

Let us create a report of your find-
ings of the study on children’s health.
First of all, you have to type in the con-
tent of the report. After typing, you can
make your report more impressive us-
ing Style. This can be done either by
using the styles available in Writer or

by creating our own styles.

Click styles and formatting on the
format menu in Writer (Pic. 2.3).

What are the styles available?

1. Paragraph style

2. ...............................................................

3. ...............................................................

4. ...............................................................

5. ...............................................................

Select a paragraph and try out dif-
ferent styles on it. You can do it by just
double-clicking on the style that you
want. Observe the changes in the
paragraph each time you apply a style.

In case you want to create your
own style, right-click on style and se-
lect ‘new’. Window for creating new
styles appears (Pic. 2.4).

You can create a new style by
changing the parameters given in the

Pic.2.2

Pic. 2.3
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Pic. 2.4

window. Now try out the style that you
have created on a selected paragraph
and observe the changes. Effect changes
in the style and reapply. See the
difference.

Sub Titles

Just as you created styles for the
paragraphs, you can create character
styles for letters (Pic. 2.5).

Make a character style and apply
it to sub titles. Improve the appearance
of your report by making different
styles and character styles.

Let’s Send the Report to Central
Minister

Now let us send this report to the
central health minister. We have to
explain that students of a school in

Kerala have studied the health status
of the school’s children, and request the
minister to  consider the findings of the
study while drawing up health
programmes. For this, let us translate a
summary of our report into Hindi, our
national language, with the support of
our Hindi teacher.

It is not enough to get the summary
translated. You will have to type it in
and take a print out. Let us see whether
we can do this on our computer.
Remember adding Malayalam key
board layout to the computer? Right
click on the key board indicator on the
panel and see its properties. We can
add the Hindi key board lay out the
same way as we added the Malayalam
layout.

Hindi Key Board Layout

Examine the position of each letter
on the Hindi key board. Examine the
Hindi and Malayalam layouts shown in
Pic. 2.6 and 2.7. Are there
similarities?

Typing in Hindi

In order to type in Hindi, the first
step is to change the key board lay out
to Hindi. Do it the way you changed the
English layout to Malayalam earlier, by
clicking on the key board indicator.
After selecting Hindi layout, practise by
typing in the words and sentences given
below. While typing in Hindi,
Malayalam etc., you should take care
to practise using the fingers correctly.

Now let us prepare the Hindi
version of our report. Do not forget to
get permission from the school authori-
ties before sending the letter to the
minister. Include a pleasant and precise
letter introducing the report to the

Pic. 2.5
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Pic. 2.6 Pic. 2.7
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File Extension
Application

needed

.xcf

.odt

.png

.pdf

.ods

.mp3

.jpg

.x ls

.doc

.mpg

.html

.txt

minister. Get support from Hindi
teachers for preparing documents in
Hindi.

Making PDF Files

Now that the Hindi version of the
report is ready, we can send it. Are you
sure if we send it as attachment to
e-mails everybody would be able to
read it? Discuss what are the likely
problems that people may have in
reading the report.

� Receivers may not have this
application on their systems

� Linux may not be the operating
system that the receivers use

� Their systems may not have the fonts
that we have used

What is the way to ensure that a
document can be read on any
computer? Discuss.

You are familiar with the tags used
with file names. These are a few letters
added after a ‘.’ in the file name. It is the
tag that tells the computer which
application is to be used for opening a
particular file. Tags are called extension
or format (Change the extension and see
the difference that it makes in the icon
in your computer). You can open and
operate a file on a computer only if you

have the appropriate application (Open
and see files of different formats in dif-
ferent applications).

Fill up the table below.

Office files and text files can be
converted into a common format called
PDF. Files in formats such as .ods, .odt,
.odp etc., thus converted can be opened
and viewed using pdf viewer. The
advantage is that the document can be
opened and read without the help of the
fonts that are used in the original
document.

Converting a file to pdf format is
easy. Open the document prepared in
office packages and click Export as pdf
in the File menu. Provide the required
information in the window that opens
(Pic. 2.8) and click Export button. File
gets converted into pdf and can be
saved in a folder.
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Pic.2.10

Page Set Up

What are the steps before printing
out a report that you have prepared?
You need to set page size, fix margins
etc. For this, click Page from the Format
menu. Make appropriate changes in the
window that opens (Pic.2.9). Won’t you
like to see how the printed page would

look like? To see it before
actually printing, go to File menu and
click on Page Preview. Click on Close
Preview to go back to the normal view.

Print Set Up

Before giving instruction for
printing, you have to provide

information such as name of the printer,
copies needed, and pages to be printed.

Presenting the Report

Don’t you remember the applica-
tion that helps you to present a report
to an audience? Discuss the method of
preparing a presentation with your
friends. Note down the different steps
involved. Prepare a presentation on the
findings of the study that you have
conducted.

Enriching the Presentation with
Video

There are video clippings related
to the topic of your study on Internet.
You may collect such a video clip with
your teacher’s help and include it in the
presentation. Click movies and sounds
in Insert menu. You can select the video
file from the window that opens. After
selecting the video, you can include it
in the presentation by clicking open.
Now try running the presentation.

Paper Format: Here we adjust the
document size to match the paper size used
on the printer.

Orientation: We arrange the orientation
of the printed text (Portrait of Landscape)
here.

Pic.2.8

Pic. 2.9
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3 Fun with Geometry

People had developed an interest
in geometrical constructions including
lines and circles, and their properties
since early ages. Several mathematical
concepts that we learn today were
discovered by them by drawing on sand
and observing. Imagine the number of
drawings they might have made to see
whether a particular property that they
observed on a particular shape could
be generalised as applicable to all
shapes.

Now we have software applica-
tions such as Dr. Geo, Geogebra etc.,
that help us draw shapes and observe
them. Last year we learned how to con-
struct geometrical shapes and observe
their properties using Geogebra. Much
more can be done using that software.
Let us familiarise ourselves with a few
geometric constructions and observa-
tions that would be helpful in our
understanding of Class IX Mathe
matics.

Drawing Polygons

It was Geogebra that was used for

drawing geometric shapes last year.
Can you recollect the shapes that we had
constructed?

� Points

� Lines

� ........................................................

� ........................................................

How did we construct a triangle
using lines? In a triangle, what tools do
we need to use to mark the following?

Parts of
Triangle Tools

Length of sides

Measure of Interior

Area of the triangle

Distance or length

angles

While constructing polygons, can
we mark their areas using the software?
Why? In order to show the area, we may
have to use a different method to
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construct a triangle. See the picture
below.

Activity 1

Draw quadrilateral, pentagon, and
hexagon in different colours using
Geogebra. Mark the length of sides,
perimeter, and area on each shape.
Then complete the table below.

Pic. 3.1

Particulars      Tool used

Length Distance or length,
Click on the side.

Perimeter Distance or length
Click on the Polygon

Area

Regular Polygons

What if the sides of a polygon are
of equal length? Such polygons are
called regular polygons. As the sides
are of equal length, we need not draw
each of the sides separately. It should
be enough to mark the two points that
determine a side and instruct the
number of points required. Do you
think if the sides of the polygon are
equal, the interior angles would also be
equal? Use the tools for drawing

polygons given in Group V, measure
the sides and angles, and fill up the
following table.

Once a polygon is drawn, how can
you increase the length of its sides? Try
moving the vertices. Which are the
vertices that move? What are the
properties of these vertices? What
happens when the lengths of the sides
are increased? And what happens when
the sides are shortened?

Number of Diagonals

You know diagonals are the lines
connecting two non-adjacent vertices of
a polygon. How many lines can we

Number of
sides

Name of
the

Polygon

Measure of
an angle

Equilateral
Triangle

3

Square

Regular
Pentagon

Regular
Hexagon

4

5

6

7

Pic. 3.2
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draw from a vertex of a square to the
opposite vertices? How many diagonal
does a pentagon have?

Activity2

Draw all the diagonals starting
from one of the vertices of each of the
polygons that we drew so far. Then try
filling up the following table.

What is the correspondence be-
tween the number of sides and the di-
agonals possible from a single vertex?
How many diagonals does a quadrilat-
eral have? What about a pentagon? Pre-
pare a table similar to the one given
above showing the number of diagonals
for each of the polygons mentioned. Do
not forget to save the shapes and write
down the observations in your note
book.

Do you see any correspondence
between the number of sides and the
number of diagonals of a polygon?

Names of Vertices of a Polygon

A polygon has as many vertices as
its sides. While constructing a polygon
in Geogebra, the software assigns
names to the vertices. Click the right

Diagonals
from a single

vertex

No. of
sides

Name of
Polygon

3 Triangle 0

4 Quadrilateral 1

5 Pentagon

6 Hexagon

7

8

button over the vertices and see the
names.

� How can we exhibit the vertex
names as labels?

�  How can you replace the vertex
names assigned by the software with
names of your choice?

� How can you display an instruction
such as ‘move me’ in place of a ver-
tex name?

Shapes with Details

Draw a pentagon. Draw all the
diagonals from one of the vertices. Now
we will try to include the names and
other details of what we have drawn.
See the following figure.

Now that you have seen the figure,
note down the steps required to add text
to the construction.

Pic. 3.3

Pic. 3.4
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1. Activate ‘Text’ tool from Group X

2. Locate the spot where you want to
include text

3. ..............................................................

4. ..............................................................

5. ..............................................................

Is it possible to change the size and
colour of the text? Click the right
button on the text and find out its
properties.

There is information provided in
Malayalam also in the figure. Try
adding more Malayalam words. Do you
encounter any problem? Why is this so?

Activity 3

Draw a triangle. Measure the
interior angles and write down the sizes.

There are two ways of doing this.

1. Measure each angle separately and
write down the sizes

2. Select the tool for measuring angles
and click inside the triangle. All the
angles get marks simultaneously.
Isn’t this easier?

Find out the names of these angles
(Click the right button over the angle
and see). What is the difference between
the names of angles and vertices?

What will be the sum of the three
angles? Do the angles of all triangles
add up to the same? Make different
triangles by moving the vertices and
check the result for each one. Can you
include your observation in the form of
a statement in the picture?

Text and Equations

How did you sum up the angles of
a triangle? Did you write down the size
of angles in a note book and add? Did
you wish if this could be done in
Geogebra? It is possible. See the figure
below.

How can this be done? Let us
examine the process of including text
once again.

� Suppose we have to write A=. The
‘Text box’ tool can be used for this.
Please do not close the completed
text box now.

� Now you have to include the angle
size in the same text box. Click on
where the interior angle has been
displayed. Note the formula that
appears. Now you may close the
box.

� Similarly you can include the sizes
of angles B and C. You can either use
the method mentioned above or type
in the required formula straight
away.

� Now we have to sum up the interior
angles and display them in the for-
mat ‘A+B+C=’. If the angles are
named α, β, and γ, then the sum we
want is (α+β+γ).

Pic. 3.5
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Now try moving the vertices of the
triangle. See what happens. Write down
your observations as a note. Can you
do another construction to figure out the
sum of interior angles of a quadrilat-
eral?

1. In order to join two statements we in-
clude + between them.

2. Static texts such as A= should be typed
in within quotes. For example, “A=’’

3. In the case of operations such as addi-
tion, brackets should be used as shown
in the figure below :

Pic. 3.6

When the angles add up to larger
sums

We already know how to sum up
interior angles of triangles and
quadrilaterals. Now let us take a look
at polygons with more sides. Follow-
ing the way we summed up the angles
in the earlier examples, the formula
to sum up the interior angles of a
pentagon should be “Sum of
Angles=”+(α+β+γ+δ+ε).  Try it out
and see what happens.

Controlling Shapes

In day to day life we are used to
controlling different pieces of equip-
ment using devices or switches exterior
to the equipment. For example,

� Voice control in the media player in
our computer

� The nob that controls the volume of
a speaker

� The rheostat that controls resistance
in electric circuits

� ..............................................................

� ..............................................................

Similarly, it is possible to control
the lengths of lines, the angle sizes etc.,
externally. ‘Slider’ is a tool used for this.

Let us construct a line and control
its length using ‘Slider’. We should be
able to change the line length by mov-
ing the slider.

For this, let us first activate the

slider by using the  tool in Group
X. The window that opens when you
click on the surface should be arranged
the following way.

Pic. 3.7

This means that the formula that we
used for triangles and quadrilaterals
cannot be used for polygons with
more sides and angles. Geogebra soft-
ware programme has been designed
in such a way that the angles should
not add up to more than 360 degrees.
Change the formula as given below
and try again.

“Sum of Angles=”+(α+β+γ+δ+ε)/ο)
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Pic. 3.9

Pic. 3.8

What all do we understand from
the figure?

� It is a value that the slider actually
controls (for instance, the length of a
line)

� The name of the slider is ‘a’ (if we
include another slider, will it be
called ‘b’?)

� The minimum value is zero

� ...............................................................

� ...............................................................

Let us now construct a line. For this,
activate the tool ‘Segment with Given
Length from Point’.

The above figure helps us
understand a few more things.

1. Slider can be used effectively only
in tools that require values as
inputs.

2. It is when we type in the name of the

slider in the input window that a re-
lationship between slider and the
construction gets established.

3. ...............................................................

There are a few other tools that can
be used together with the slider. See the
list below. Also try finding new tools.

What about a slider that controls
the size of angles? Let us draw a circle.
First we select a point on a plane. Then
imagine another point that moves on
the same plane at a constant distance
from the first point. As the distance with
the original point is constant, the sec-
ond point cannot move away. It can only
circle 360 degree around the first point.
You know the route traversed by the
second point forms a circle.

Activate a slider and arrange it as
given below.

What are the changes that have
been made in this slider window?

� Instead of a number, the radial but-
ton of an angle has been selected.

Pic. 3.10
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� Slider’s name has been changed from
a to alpha

� ...............................................................

� ...............................................................

Now construct an angle and fix it
size as alpha in the slider. It can be done
the following way.

1. Construct a small line. Let it be the
base of the angle.

2. We have to construct the angle on
this base. What is the angle size?

3. ...............................................................

...............................................................

...............................................................

Once constructed you can see the
angle marked (in the existing
measure in the slider alpha).

4. What we have to mark is the route
traversed by this point. In order to
do this, click the right button and
activate the tool ‘Trace on’.

5. Now select ‘move’ tool and move the
slider and see, what is being
constructed? Click the right button
on the slider, activate animation and
see.

Pic. 3.11

Not only in Geometry, but in
Malayalam as well

Geogebra is not just a software for
easy learning of Mathematics. It helps
in doing several activities in different
fields and makes learning more
interesting. Let us try doing an
exercise in the history of language.
Suppose the slider is for chronology.
Suppose we want to display the
major events in Malayalam language
during the period 1700 to 2000. For
instance, when the slider reaches 1705,
the window should display an image
of Kalakkathu Kunchan Nambiar and
other information relating to him.

How can we do this?

1. We have to collect an image and
other relevant information

2. Then open a window in Geogebra
and include a slider in that. Now
you can include the image that we
have collected.

3. Click the right button to open
window displaying the properties
of this image

4. You can specify the conditions for
displaying this image in the space
marked ‘Advanced’. The condition
here is that the image should be
displayed when the slider reaches
1705. Or mathematically, a≥=b.

5. What should we do if the image has
to disappear once the slide moves
out of the period of Kunchan
Nambiar’s life?

In a similar manner, can you
construct the periodic table used in
Chemistry? You should include
information and pictures of various

Information & Communication Technology



� 31

Dilation

Dilation is an American usage. It
means to enlarge something. The tool
called ‘Dilation’ is used for enlarging a
shape based on the distance from a
given point. We can instruct on the
Dilation factor (How much we want to
enlarge). This factor can also by
controlled using a slider.

Activity 4

Construct a circle using the tool
‘circle with centre and radius’. Suppose
we want to enlarge this circle three
times based on its centre. What would
be the steps to do this? See the figure
below.

Activity 5

♦ Draw a circle with A as centre. Mark
two points C, and D on it.

Pic. 3.13

♦ Draw chord CD

♦ Construct a slider that accepts
values from 0 to 1

♦ Dilate C based on as much as the
value shown in the slide. Let us
name the new point as C’

♦ Join AE and mark angle ACID

♦ What happens when you move the
slider? When does ∠ ACID becomes
90 degrees?

Activity 6

Construct a rectangle (how to
draw?). Draw a triangle in the
rectangle as shown in the picture. What
would be the areas of this triangle? If
we move the upper vertex along the
upper side of the rectangle, will the
triangle’s area change? Can you explain
this idea to your friend by controlling
the movement of this vertex using a
slider?

When slider is used for dilation
factor (assume dilation factor is a)

� If the value of a is 2, then double
the size of the shape

� If the value of a is 0.5, dilation
would be to reduce the size by half

� When a equals 1, there is no
difference between the base point
and the dilating object. Therefore
the dilated shape would be 100%
of the original shape.

� You find out and tell what happens
when a becomes zero.

Based on this, can you explain the
dilation using a slider with value
ranging from zero to one?

Fun with Geometry

elements in it. Other examples worth
trying are stages in evolution, the
structure of the earth and atmosphere
etc.

Pic. 3.12
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Pic. 3.14

What is the use of a pencil? We can write with it. Draw with it. That is all
right. But can the pencil be used only for writing or drawing? See the following
figures.

This also can be considered another use of the pencil. Similarly Geogebra
is not  used for geometrical constructions only. See the pictures below. A cycle
rider and an ant eater have been represented using Geogebra.

���
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You have familiarised yourselves
with Internet and ways of collecting
information from Internet in Class VIII.
You also know how to open a website
using a web browser.

Open and see the website of
IT@School. What all do you see on the
home page?

Move the mouse pointer through
the home page.

Don’t you see a change in the shape
of mouse pointer when it reaches some
of the words and pictures in the home
page?

Click the mouse button where the
shape of the mouse pointer changes.

Pic. 4.1

The Secret Behind Webpages4
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You can see new web pages opening.

In books and magazines,
information is printed on sheets of
paper.  Web pages are the sheets on
which information is displayed in
Internet/ web media.

What are the differences between
the paper sheets in print media and the
web pages?

� The content in the webpages are not
static. They can be changed.

�   Webpages are linked.

� Sound and moving pictures can be
included in a web page.

� .............................................................

� .............................................................

� .............................................................

How many pages are arranged in
a web site?

� Important information on the site
would be included in the main page
(home page)?

� They would be links connecting the
home page with other pages.

� ..............................................................

� ..............................................................

� .............................................................

Making Web Pages

How are web pages made? In
order to make web pages, we have to
know a computer language called
Hyper Text Mark up Language or
HTML. The programmes done using
HTML in the text editor called gedit can

be viewed as web pages using a web
browser.

Let Us Make A Web Page

Your English textbook talks about
several writers. Remember the poet
Alexander Pushkin who wrote the
poem ‘To My Nanny’ given in the first
unit of the English textbook? Let us
make a simple web page that displays
his name.’

Activity 1

All pages start with the opening tag
<html> and ends with the closing tag
</html>.  Note that html is written here
within ‘< >’ brackets. These are called
tags. Tags are used in pairs of an
opening tag and a closing tag.
Therefore, a website has to be
constructed within the two tags -
<html> and </html>.

What are the steps to display the
name ‘Alexander Pushkin’ on a web
page? Open a text editor and type
<html>Alexander Pushkin</html>.
Save this file after assigning it a name.
You have to add the extension ‘.html’
or ‘.htm’ at the end of the file name (See
Pic. 4.2).

Pic. 4.2
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Pic. 4.3

Let Us Open and See this Web
Page

Let us see how we can open this
web page using the web browser called
Mozilla Firefox. Right click on the text
file that has been saved with the
extension .html. Go to the menu and
click on the option Open with Firefox
Web Browser. See the web page being
displayed with Alexander Pushkin’s
name printed on it.

What is There in a Name?

In the past, the people working in
printing presses used to be given
instructions using certain symbols. These
symbols, which indicated the size, colour,
and other properties of the text to be printed,
used to be called ‘mark ups’. HTML is
called a mark up language as it has a
similar function to those symbols of the
past.

Now,  you can also create a web
page that displays your name. Write
down what needs to be typed in the text
editor including tags in your notebook
first. Then type down these content in
the text editor, and repeat the above
steps to open and see the web page.

HTML Tags

Tags are codes used for
instructing the web browser how to
display the content on each web
page. Instructions/content are typed
in between the symbols ‘<‘, ‘>’. The
tag used at the beginning of the
instruction is called ‘opening tag’.
Where the instruction/ content ends,
the tag has to be closed. A closing tag
is formed by adding ‘/’sign after the
‘<‘ sign. In short, an instruction or
content is valid only in the space
between the opening and closing
tags.

Headings on Web Pages

Headings and sub headings are
used to indicate topics and their
relative importance in your text books.
Similarly, web pages also require
headings and sub headings. There are
tags available for displaying
headings in different sizes.

Activity 2

The main heading on the web page
that we are designing is to be Alexander
Pushkin. The tag for this is <H1>.

� Do you thing this tag is in some way
related to the word Heading?

Open the file that had been saved
with the extension .html using gedit
(You may right click on the file, and click
on gedit in the Open with menu (See
Pic. 4.4).

Type down the following lines one
by one between opening tag <html>
and closing tag </html>, and save the
file. Open the file using web browser
and see the difference in the way

Pic. 4.4
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headings are displayed.

<h1>Alexander Pushkin</h1>

<h2>Alexander Pushkin</h2>

<h3>Alexander Pushkin</h3>

<h4>Alexander Pushkin</h4>

<h5>Alexander Pushkin</h5>

<h6>Alexander Pushkin</h6>

Can’t you use the above tags to
provide headings and sub headings of
the right proportions to the contents of
the web page?

When you opened the file in Text
Editor, did you notice anything
peculiar about the letters which made
it difficult to distinguish between tags?
What were those peculiarities?

....................................................................

....................................................................

Do not forget to save the changes
while providing instructions for
changing the font size of titles. After
saving the changes made in the Text
Editor, you can observe the changes by
clicking the ‘Reload’ button in the
browser.  Another way to reload,  is to
click View and Reload in that order. If
there are  typing errors in tags or
missing tags, the web browser will not
accept the instruction.

Starting New Lines

On the web page, in order to start
a new line, the required instruction has
to be given to the browser. <br> is the
tag used for starting a new line after
breaking a line.

Activity 3

What we are trying to develop is a
web page containing a brief profile of
Alexander Pushkin. Let us see how we
can include a simple description on him
in two lines.

Born in Moscow, Russia

He is Russia’s Bard

Make the required changes in the
Text Editor for displaying these pieces
of information in two lines.

As there is no content between the
tag </br> which ends a line and the tag
<br> which starts a line, both the tags
can also be combined and written as
<br/>.

Making the Letters on the Web
Page Look Pretty

You must have noticed the use of
bold, italic, and underlined letters in
books for highlighting important points
or portions.  You have learned to do it
on office software tools. How do we
give such instructions on the web page?
What would be the tags to be used?

Activity 4

Suppose we wish to make two
newly added lines bold. The tag for this
is <b>. Include the instruction regard-
ing the exact lines or words to be made
bold and display it on the web browser.

Please note that ‘b’ is the first letter
of the word ‘bold’. The tags you are
learning here are all related to the
instructions associated with them. Use
the tag to make bold letter italic, and
also the tag for underlining them
alternatively and see the difference.
Tabulate them.
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In order to make the letters bold

<b>

For tilting the letters

.............................................................

For underlying the letters

.............................................................

Changing the Font Size and
Font Colour

If you want to change the size of
the name Alexander Pushkin, you can
do that by increasing the font size. You
will have to include <font size=5>
before the name and add the closing tag
</font> at the end. In order to change
the font size, you can change the
number in size=5. Instead of 5, input
other numbers and see the difference.

Changing the Font Colour

What instruction will make the
colour of the letters red?

<font color=”red”>

Please note that the word ‘colour’
is used as ‘color’ in the tag.

Activity 5

Write down the changes to be made
in the Text Editor for changing the font
colour into green.

<html>

…..................................................

…..................................................

…..................................................

</html>

Including Paragraphs

Now let us try to include some
more description on Alexander Pushkin
in the web page.

You will be able to do this. Give it
a try. If these are more paragraphs, the
tag to be used for starting a new
paragraph is <p>. You can easily guess
the corresponding closing tag. Can’t
you?

While ending a line and starting a
new one, and also while ending a
paragraph and starting a new one, do
you see anything noticeable in the place
of the next line?

Activity 6

Including a Picture

Including a picture in the web page
that you have designed will make it
more attractive. Only that the required
picture should be available in our
computer. You should locate the folder
in which the picture is saved. In order
to include the picture, we have to right
click on the file containing the picture
and examine Properties Location (See
Pic. 4.5). Give the file name of the

Pic. 4.5
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picture along with its location address ,
within the tag <img src=”...............”>.

Where do you want to include the
picture? What about setting it below the
name ‘Alexander Pushkin’? See the
location of the file Pushkin.jpeg within
the <img> tag.

<img src=”/home/user1/desktop/
Pushkin.jpeg”></img>

Design web pages by including
other photographs and images saved in
your computer.

Activity 7

Moving the Letters

You must have seen the scrolling
flash news bar on TV screens. We can
also include a scrolling sentence in our
web page. For example, if you want a
sentence ‘This web page was created by
English Club, ….............. High School’
to scroll along the web page, type this
line between the tags <marquee>,
</marquee> and save. Then open the

Pic. 4.6

web page using the web browser and
see.

We can also decide on the direction
in which the sentences scroll. Change
the opening tag  <marquee> to
<marquee direction=right> and save
the file. Open the web page and see the
difference. Instead of right, provide up,
down, and left alternatively and observe
the difference. Please remember to
tabulate your observations.

Changing Background Colour

What is the background colour of
your web page now? You can change
the background colour the way you
want. Suppose you want to change it to
yellow.  As the page starts from above
the heading, type in <body bg
color=”yellow”>. And provide a
closing tag at the end.

Activity 8

Try out different colours on your
web page and make it attractive by
selecting the colour of your choice.
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Adding a Heading in the Title
Bar

Suppose you want to display
‘Alexander Pushkin’ in the title bar of
the web page. For that, you have to
include the title within the tags <title>
and </title>. Note that this instruction
has to be typed above the html codes
written for the page. Save it and open
through the browser and see. How has
the title of the web page appeared?
(Pic. 4.7).

Activity 9

You have familiarised yourself
with a few HTML tags in this chapter.
You have also understood that most of
the tags are related to the first few
letters of the corresponding instructions
in English. Can you now tabulate all the
tags that you have seen the following
way.

Tag Instruction

<b> To make the letters bold

<i> To italicise the letters

….. …........................................

….. …........................................

…... …........................................

Pic. 4.7

What is hyper text?

You have seen that the mouse pointer looks
different while moving over certain words
and images on a web page and that if you
click on those areas, new web pages open.
Hyper text is the text marked up in such a
way that when you click on it, it takes you
to another page or image.

Search for more information on the
writers mentioned in Malayalam and
Hindi text books. Include the
information that you come across and
create web pages using them.

Create a web page explaining the
activities of your school club.

Activity 10

Open a web page using the
browser and click the right mouse
button on that page. Select ‘View Page
Source’ option in the menu that
appears. Now the HTML code of the
page will appear. Examine it closely.

♦ How is hyper text marked up in this
page?

♦ What are the HTML tags used for
the hyper text?

♦ Which are the HTML tags that have
been used? Note down the tags
below.

......................................................................

.....................................................................

.....................................................................

......................................................................

���
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5 The Way Computers Work

Computers are good friends that
help us in studying, playing, listening
to songs, and watching movies. They
are electronic equipment that works
according to our instructions. How do
computers understand our instructions
and work accordingly? Operating
systems are the basic programs that
coordinate and control the working of
various components of computers. In a
way, operating systems are almost like
the life of computers.

We know certain other pieces of
equipment too that work according to
our instructions.

� Mobile Phones

� Automatic Washing Machine

� Billing machines of various types.

All these equipment work as per
the programmes that have been
prepared and installed in them in
advance. Such programmes are their
operating systems.

We use computers for numerous
activities including playing songs,
watching films, typing and storing
information, preparing tables and so on.
For computers to perform all these, the
corresponding programs have to be
installed in them. Such software is
known as application software. GIMP
and Calc are application software that
we are familiar with.

What are the activities that
computers can perform in addition to
those mentioned above?

� They store information as files in
them.

� They allow us to arrange the look and
feel of the system the way we want
them to be.

� They can connect to as well as
control peripheral devices such as
printers and scanners.

� They allow us to access
communication media such as the
Internet.
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There are various operating
systems that are used in computers. We
use Linux in school. Several other
operating systems including Windows,
Mac, Unix, and Solaris are used the
world over.

Activities

♦ Download information on operating
system, differenct operating
systems etc. from the Internet,
prepare notes on them and include
these in your class magazine.

♦ Organise a discussion on free and
open software in the class. Down-
load relevant information from
Internet. You may use the
following leads for the discussion.

♦ Which is the operating system used
in your school?

♦ Is it free and open software?

♦ Are there any advantages in using
it?

♦ Which are the free and open
operating systems available today?

Richard Mathew Stallman

Founder of Free Software Foundation. He
is the one who conceived
and developed the world
famous GNU operating
system. He has dedicated
his life to the
popularisation of free
software.

Operating systems are programs that
coordinate and control the various
components of computers. Unless these are
installed, computers cannot work.

� Operating systems work as the
interface between input output devices
and application software.

� It controls with memory, file system,
and the organisation of computers.

� It coordinates and controls the various
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The inventor of the Linux kernel used
in the operating systems belonging to the
GNU/Linux family is a famous software
engineer.

components and processes of the
computer.

� There are proprietary software which
are to be bought from the market and
free software which are available for free.

� In the case of proprietary software,
buyers do not have any control over the
software. They cannot make any
changes in the software; neither can
they share it with others.

Free software is available for public use
without paying money. Free operating
systems are also available in the public
domain.

� In the case of free software, we are free
to run any programme for any purpose

� It offers us the freedom to understand
how it works, and incorporate changes
as per our requirement

� We have the freedom to re-distribute
copies of the software

� We have the freedom to improve them
and release modified versions

Several free operating systems such as
GNU/Linux, Open BSD, Sun Solaris etc.,
are available today.

Linux Benedict Torvalds

Now let us start using the
computer. You are familiar with the
desktop that appears when a computer
is switched on. You must have seen
desktops with attractive appearance.
Why don’t you also make your desk-
top attractive by including pictures and
photographs that you like?
Changing Desktop Background

Place the mouse anywhere on an
empty space on the desktop and click

Pic. 5.1

GNU/Linux

GNU/Linux is one of the most
popular free operating systems. It evolved
from the synthesis of the software devel-
oped as part of the GNU project initiated
by Richard Stallman in 1983 and the
Linux kernel that Linus Torvalds devel-
oped in 1994. The name GNU/Linux
indicates this synthesis.

Several free software applications that
are needed to work with free operating sys-
tems are also available now.



The Way Computers Work

43�

the right button. Select Change Desk top
Background. Now you can select the
desktop background of your choice
from the Appearance Preferences
Window that appears (Pic. 5.1).

Now try adding pictures and
photographs that you like as desktop
background.

� Click Add button in the Appearance
Preferences Window

� ..............................................................

� ..............................................................

Aren’t you able to set your pictures
as desktop background?

Activities

♦ Download pictures from Internet
and set them up as desktop
background

♦ Take a photograph of your school,
make it attractive by editing it in
GIMP and set it as desktop
background

Making Desktop Setting Attractive

Now we know how to change
desktop background. Similarly, we can

Pic. 5.2

also change the appearances of the icons
and menus on the desktop and make
them attractive. For this, open the
Appearance Preferences Window by
selecting Appearance from Preferences
in the System menu (Pic. 5.2).

Make appropriate changes in
Theme and Fonts seen in this window
and see the differences that can be made
to the desktop. Prepare a note on these.

Making a Screen Shot

Screen shots are pictures captured
from your computer’s desktop.  These
may include the desktop background,
icons, open windows, or whatever
being displayed by a program
currently running on the computer.
Many of the pictures in this textbook are
screen shots. Let us familiarise with the
ways of capturing screen shots.

� Open the window/icon/part/
display that you want to capture a
screen shot of

� Press the Print Screen button on the
keyboard

� The screen shot appears in a new
window. Assign a file name and
save it

Now try another method.

� Open Ksnapshot by pressing
Ksnapshot from Graphics in the
Applications menu

� Click New Sanpshot after selecting
Region from Capture Mode

� Select the area of which you want a
screen shot by dragging the mouse
pointer

� Press Enter
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� Save the screen shot using Save as

� There are different ways of making
screen shots

� Open Take Screenshot window by
clicking Take Screenshot from
Accessories in the Applications
menu

� ..............................................................

� ..............................................................

Activities

♦ Prepare the screen shots from a
picture in GIMP using different
methods and save them.

♦ Make a molecular model of water
using chemical software and capture
and save its screen shot.

Recording Screen Displays

You might have seen video films
that display and demonstrate software
applications. For example if the
working of Sunclock is displayed in
video, it would be easy for us to
understand its principle. Let us now
use gtk-recordMyDesktop, a software
that helps us record the displays on the
screen in video and reproduce it after
mixing adequate sound.

Click in the order Applications →
Sound & Video → gtk-record
MyDesktop to open the gtk-record
MyDesktop window (Pic. 5.3).

� Click Record button

� Now a white square appears on the
panel

� Now open the software or applica-
tion that has to be recorded

� Once the software or application
completes its cycle, click on the white
square on the panel

� The white square transforms into a
red circle and a new window opens
(Pic. 5.4) on the screen.

� Within a little time, the first window
(Pic. 5.3) re-appears, you can save
the video by clicking Save As.

If you want to include voice in this
video, you can record the sound while
recording the video itself using
microphone. For this click Record
button and even as the software or
application runs, record the voice also
through the microphone.

Activities

♦ Use gtk-recordMyDesktop to record
the opening and use of word
processor in video, and include
required narration as voice.

Pic. 5.3

Pic. 5.4
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Pic. 5.7

♦ Note down the way this is done.

Adding and Removing Panel

You might have noticed the panel
that looks like a white ribbon at the top
and the bottom of the computer screen.
On the panel you can see menus such
as Applications, Places, and System,
and a few small icons. Bring the mouse
pointer over each of them and see their
use (Pic. 5.5).

Try and see whether you can add
anything more to the panel.

Pic. 5.5

� Place the mouse pointer over the
panel and click the right button

� Select Add to Panel

� Select the required options from the
window that opens (Pic 5.6) and
click Add

What do we do to remove some of
these from the panel?

� Bring the mouse pointer over the
item to be removed and right click.

� Click Remove From Panel

You can also change the colour and
size of the panel.

� Right click mouse over the panel

� Select Properties.

� Figure 5.7 opens.

Now change the colour and size of
the panel. Try making other possible
changes on the panel and note down the
steps involved.

Pic. 5.6
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Setting Date and Time

Note the month, date, day, and time
displayed at the right hand side of the
upper panel. Some times you may have
to change the time and date. How do
we make such changes? Let us try.

� Click the right button of the mouse
where time, date and month are
displayed

� Select Preferences

� In the window that opens (Pic 5.8),
click on Time Settings

� Make required changes in the month,
date, day and time in the new
window that opens.

� Click on Set System Time and
provide password.

Creating a New User

We operate the computer using a
user name and password. Do other
children in the class also use the same
user name and password? If yes, do you
find any problem with that? Note down
your observations below.

� Desk top background and icons keep
changing

Pic. 5.8

� Some of the files and folders have
been either deleted or subjected to
changes

� ...............................................................

� ...............................................................

What is the solution to this? The
best way is to create a separate user
name for each user. Let us see how new
users can be created.

Open the User Settings window by
clicking in the following order (Pic. 5.9).

System → Administration →
Users and Groups

� Provide administrative password
after clicking on the icon Click to
Make Changes

� Click on Add User and type in new
user name and password

Now create a user by your name.
Do not forget to note down the steps
involved.

Setting Resolution

You might have seen some com-
puters having large icons on their desk
top. In addition, some windows are
only partially visible when open. This
problem is caused by low screen reso-
lution. Let us see how we can fix the
appropriate screen resolution.

Pic. 5.9
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� Open the Display Preference win-
dow (System → Preference →
Display – Pic. 5.10).

Pic. 5.10

� Click on resolution and select the
appropriate screen resolution.

Observe the changes on the desk
top and in different windows while
using different resolutions.

Setting Screen Saver

Keep your computer idle for a
while. See what happens. Some pictures
and shapes appear on the screen. See
some of them moving around and
rotating. These programs are called
screen savers. Let us see how different
screen savers are set.

� Open Screen Preferences window
(Pic. 5.11) by clicking in the order

Pic. 5.11

System → Preferences →
Screensaver.

� Set appropriate screen saver and
time

Familiarising File System

You know that information is stored
in computers in files kept in folders. If
you want to keep a file that you have
created, how do you save it?

� Click on Save in File menu

� In the window that opens, provide
a file name of your choice and click
save.

� Suppose you forgot to select a folder
while saving, how do you figure out
where the file has been saved? Let
us try.

� Click on Search for Files in Places
menu and open the Search window

Running an Application Using Terminal

You must have seen the difference in the way application software are arranged in the
menus of different versions of GNU/Linux. We can also run the applications without
using the menu, by using terminal. In order to do this, right click the mouse in an empty
space on the desktop. Click Open in Terminal to open terminal. Then type in the name
of the software you want to run and press Enter. Try entering GIMP in the terminal. If
you want to open office writer, you have to type oowriter.
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� Click Find after typing in the file
name

Your file appears on the screen.
Note where it has been saved. It must
have been saved in the Documents
folder inside the Home folder on the
desktop.

Observe the sub folders and files
in the Home folder. Open the Home
folder by clicking in the order:
Computer → File System → Home.
Open your user folder that appears.
Aren’t the files in both the folders the
same? What conclusion would you
reach from this observation?

� Home folders of all users appear on
their desktop

� Select  Computer → File System →
Home to see all user homes

� ..............................................................

� ..............................................................

� ..............................................................

Find more facts to complete the
note.

� Prepare a new file and  save it in
various user homes and desktops
using the Save As command

� Login to those users and examine
the files.

���
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All children like swings. What if
we make swinging a scientific
experiment? Then learning also
becomes as exciting as swinging. You
already know that movements of baby
cradles and swings are oscillations. Do

On a Swing

PhET
PhET is a collection of science simulations developed by a group of scientists at Colorado
University. You can open PhEt by proceeding in the following order: Applications →
School Resources → PhET.  Click on the link ‘Play with sims’. A window opens. In order
to open a simulation in physics, you can select the link Physics. Select Pendulum lab.
Another window opens. Click Run Now. If you want online PhET,
visit http://phet.colorado.edu

the oscillations of a swing vary
according to the length of the rope? Or
according to the weight of the person
sitting on it? Let us examine the
properties of oscillations using a
simulation.
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Observe the main window of the
Pendulum lab. What are the tools given
on its right hand side? See the change
in the window when the length of the
pendulum is changed. What is the
difference that occurs to the main
window when you vary the mass? What
all appear in the window when you
press Other Tools at the bottom? Note
down.

Activity 1

Open PhET pendulum lab. Using
the length tool given on the right hand
side, fix the pendulum length at 2m. Fix
mass at 1kg using mass tool. Move the
pendulum bob using mouse to either
side and release (Pic 6.1). You can see
pendulum oscillating.

Click on other tools given on the
right hand side of the pendulum win-
dow and bring in digital stop watch to
the window. Find out the time for ten
oscillations of the pendulum using the

Pic. 6.1

digital stop watch. Also figure out the
use of pause/play button in the
window and reset, start/pause button
in the stop watch.

Activity 2

Oscillate a pendulum of 1m length
and 1kg mass. Fill up the table with the
time taken for 10, 15 and 20 oscillations.
Find out Period (T) and Frequency (f)
of oscillations. (Table 6.1)

Activity 3

You might have seen old
pendulum clocks. You know that in
pendulum clocks, time and oscillations
are related. What are the changes made
in a pendulum to adjust time? Observe
the pendulum and conclude.

Find out the time taken for 10
oscillations by a pendulum of 1m
length and 1kg mass. Repeat the
experiment after changing the
pendulum length to 1.5m, 2m etc. Fill
up the Table  and calculate the relation-
ship between pendulum length and
Period. (Table 6.2)

Activity 4

Repeat the experiment by keeping
the pendulum length constant and
changing the pendulum mass (.5kg, 1kg,
1.5kg). Fill up the Table, calculate
Period, and find the relationship
between pendulum mass and Period.
(Table 6.3)

Time for single
oscillation,

Period T= (t/n)

1 10

2 15

3 20

 Sl. No. Number of
Oscillations Time (t)

Number of oscilla-
tions per second,

Frequency (f) f= (n/t)

Table. 6.1



On a Swing

51�

Clan of Elements

In a place not so far away, there
lives a clan with several families
branching out of it and every family
with several members. Do you know
what is special about this clan? The
entire world is made out of the
members of this clan. Who are those
members? They are elements that form
the fundamental matter of all the things
in the world. Then which is the clan that
all the elements belong to? We have
already studied them in detail. The
modern periodic table in which
elements are arranged according to their
atomic number can be called the clan of
elements. As you know, every member
of this clan is unique with its own
specialities.

Number of
oscillation

(n)

Sl.No.
Mass
(Kg)

Time (t)
Time taken for a single

oscillation, Period
T= (t/n)

Table. 6.3

1 0.50 kg 10
2 1 kg 10
3 1.5 kg 10

Length of Pendulum = 1 m

Number of
Oscillation (n)

Sl.No.
Length (l) Time (t)

Time taken for a single
oscillation, Period

T= (t/n)

Table..6.2

1 1m 10
2 1.5m 10
3 2m 10

Mass of Pendulum Bob = 1 kg

Finding properties of elements and
analysing them are subjects that you
handle in the Chemistry classroom. We
have understood in Class VIII that
various IT tools can be used to make
learning chemistry much more interest-
ing. Which were the software that you
had worked with? What were the

♦ ............................. ♦ ...........................

♦ G-Periodic ♦ To find the
names and
symbols of ele-
ments.

♦ .............................

♦ .............................

♦ .............................

♦ ............................

♦ ...........................

Software        Use
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special uses of those software? Let us
tabulate them to refresh our memory.

Software can also be used for
analysing the modern periodic table of
elements. Periodic table of the elements,
Kalzium etc., are software applications
that can be used for this.

Use the software Periodic table of
the elements and see how interesting
can be the study of modern periodic
table.

Activity 5

TipsApplications → Science → Periodic table of

       the elements

View → Colour Scheme → Family

Selected Family → Alkali Metals

Open the software  Periodic table
of the elements and display each
family on the periodic table. All these
families are members of the large clan
of periodic table. Among the families
that you have displayed, select any
three, and fill up the following table
based on them (Table. 6.4).

You now know a few of the
element families. Have you noticed the
fact that each of these families occupies
separate columns in the periodic
table? How many families (columns)
are there in the modern periodic table?
You know that the rows in the periodic
tables are called Periods. How many
periods are there in the modern
periodic table? Check.

Activity 6

♦ Use the software  Periodic table of
the elements to find out the positions
of the following families in the
modern periodic table (Table. 6.5).

Table. 6.4

Family
Number

Family Name Alkali Metals

Elements

Li

Na

.......................

.......................

.......................

..................

..................

..................

..................

..................

1

Pic. 6.2
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Find Representatives

You know each element has its own
properties. Even then there are
commonalities across the elements in
the same group. And there are some
elements that are representative of such
groups. The software can be used to
arrange the periodic table to include
only the representative elements.

We had done a few experiments
with Kalzium software in Class VIII.
Now let us try some of the experiments
from Class IX using Kalzium. Try the
following on Kalzium software.

You will get the table shown in
Pic 6.4.

♦ Which are the groups in the table?

♦ Are there metals, non-metals, and
metalloids?

Why are metals arranged in
families or groups?

We have seen that elements are
arranged in eighteen families or groups
in the modern periodic table. What is
the basis for this classification of
elements into families? In order to find
this, we need to examine the electronic
configuration of elements. For this,
observe the electronic configuration of
representative elements from two or
three groups and write it down in
Table 6.5.

Compare the group number and
the number of electrons in the last shell.
What is your inference from this?
Compare it with what others have to
say.

Elements in Periods

We have understood the
relationship between group number
and the number of electrons in the last
shell of the elements in the group. Is
there any relationship between
electronic configuration and the
position of elements in periods?
Let us see.

View → Numeration → No Numeration

View → Tables → Short Periodic Table

View → Scheme → Family

Pic. 6.3

Position of the
Periodic Table

Transition Metals

Metalloid series

Lanthalloid series

Actinide series

Elements

Table. 6.5

3rd to 12th Groups
(Families)

Pic. 6.4

Tips



Activity 7

Find out the electronic configuration of a few elements from two or three
periods and fill up the following table.

Kalzium for Comparing Atomic
Size

You know that elements are
arranged according to their atomic
numbers in the modern periodic table.
When elements are arranged thus, how
are the properties of elements related
to their relative positions in the periodic
table? We can use software to
understand the progressive changes in
the properties of elements as we move
from one end to the other in the
periodic table.

For example, let us see how the

With the help of this table, can you
figure out the relationship between the
number of shells and period number?

Let us play a game?

Prepare a periodic table of
representative elements alone using
Kalzium. Let one of our friends exhibit
the electronic configuration of one of the
elements (Pic. 6.5) (Adjust the window
to hide the element name and details).
Let other friends find out the position
of the element in the periodic table.
Press next button, change the element,
and continue the game.
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Group Number: 1 Group Number : 2  Group Number : 16

Elements
Number of

electrons in the
outer shell

Elements Elements

H

Li

...........

...........

1

1

.............

.............

Table. 6.6

Number of
electrons in the

outer shell

Number of
electrons in the

outer shell

Peiod : 2  Period : ............... Period : ................

Elements Number of shells Elements Number of shells Elements Number of shells

Li

C

O

2

2

2

Table. 6.7
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Pic. 6.5

atomic size of an element is related to
its position in the period. For this click
on Plot Data in the Tools menu. A
window opens (Pic. 6.6). Inside the
window, set atomic number on the X
axis and atomic radius on the Y axis.
Provide 3 and 18 respectively in the

Pic.6.6

place of First Element and Second
Element in the window. Select Element
Symbol in Display and All Elements in
Element Type.

You get a graph. Discuss the graph
based on the tips given below.

Hints

� The elements with the lowest and
the highest atomic radius in
Period 2.

� The positions of the above elements
in the periodic table.

� The change in atomic radius in
Period 2.

� The change in atomic radius in
Period 3.

� Overall change in atomic radius in
Periods.

���
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7 Sound Recording in Computers

“The scorching heat of the fiery deserts
The unending disquiet of the deep seas
And the faltering hymns of the passing river
That watches the vanishing lush green shades”

You have already read this poem
written by the Jnanpith winning poet
O.N.V. Kurup. As part of reading this
poem, shall we prepare an essay on the
writings of O.N.V. Kurup and post it
on the school blog? In the past we used
to publish such creative work in the
school magazine. Now we can even
create a digital magazine using
information communication technolo-
gies.

What are the advantages of
publishing on the blog over publishing
in a school magazine? Tabulate the
advantages that you see.

� We can publish articles of our choice

� We can edit even after publishing,
if needed

� ..............................................................

� ..............................................................

You have understood the advan-
tages of publishing on the blog. You can
also post poems and folk songs that you
sing on the blog, which is not possible
in a printed magazine.

In order to prepare such content
with songs sung and poems recited on
a computer, you have to do some
preparations. Let us see what are the
preparations needed.

� Selecting poems or folk songs

� …...............................................

� …...............................................

Let us start recording

We need software that can record
sound into digital media for recording
what we speak or sing.

Connect microphone to the
computer, open Audacity software, and

start reciting the poem. Click  icon

to start recording.
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Sound Recording Using Audacity

Activity 1

Have you finished recording your
poem? Which tool do you use to end
recording? What are the other tools used
for? Use, find out, and note down.

Pic.  7.2

Pic. 7.1

Audacity Window

Audacity is a software used for recording
and editing sound in digital media. In
addition to GNU/Linux version, Audacity
is also available in versions that are
compatible with BSD, Mac and Windows.
To open Audacity, select Audacity from
Sound & Video in the Applications menu
(Pic. 7.1).

For editing nodes in the sound

For handling more tools
simultaneously

......................................................

......................................................

......................................................

......................................................

......................................................
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......................................................

......................................................

......................................................

......................................................

Activity 2

While recording a poem, it is quite
natural that some of the lines might not
have been recited to your satisfaction.
It is also possible that some noise has
crept in. We can correct all these. In
addition, we can also combine parts of
the poem recited at different times to
save them as a single sound file. Delete
the unwanted portions in the sound files
that you have recorded.

Editing Using Audacity

Saving the file

You can save the project file in
Audacity by selecting Save Project from
the File menu and by providing a file
name. Note that the file is saved with the
extension .aup

Pic. 7.3

We can select the unwanted sound portions
and delete them by pressing delete key
(Figure 7.3). We can also select files in the
track and arrange them in appropriate
places using copy and paste tools.

Activity 3

Export the poem or song that you
have recorded into mp3 format.

Sound Effects

Audacity can be used to edit the
sound files stored in the computer and
to create various ‘sound effects...’. Open
sound files using Open button in File
menu, select the portion where you
want an effect, and impart the required
effect to the sound file through Effect
menu.

Follow up Activities

� Today’s News – Prepare the events
in the school in the form of a news
bulletin and present it. Record the
news and save them in ‘ogg’ format
in your folder.

� Cut out a portion that you need from
a sound file stored in the computer
using Audacity, provide Fade in and
Fade out effects and export the file.

In order to post on blogs or to include in
presentations, we have to merge all the
sound bits in the Audacity project file into
one file and save it. For this we have to
export the project file by selecting Export
option from the File menu. A window
opens in which we can provide file name
in the Name box. Select the appropriate
extension tag from the box for selecting the
file type and click Save.
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Files Size (kb/mb)

mpg
flv
d v
ogg

Table 7.2

When we receive sound files or
other sound and video files thus
exported, how do we make those files
work on our computer?

It is easy to see and hear the sound
and video files stored in our computer.
Right click on the file. In the window
that opens, click on Open with and
select the appropriate media player
software, and open the file in that
software.

Media Players

Media Players are the software
applications which are used for operating
sound and video files on computers.
Totem Movie Player, VLC Media Player,
SM Player, Xine, Rhythm Box Music
Player etc., are the main players available
on GNU/Linux. Understand the file
extensions in Table 1, collect sound and
video files in those formats, run them
using media players, and fill up the table.

Table 7.1

File Formats Sound-Video Files

mp3 Sound Files
avi Movie Files
mpg .................................
dv .................................
flv .................................
swf .................................
ogg Sound-Video Files
3gp .................................

You can now recognise sound and
video files of various formats. Among
them what are the properties of flv and
swf files?

� These files cannot run with all types
of movie players

� ..............................................................

Understanding File Size

Have you noticed the properties of
other sound and movie formats? The
file size varies according to the file
format. Fill up Table 7.2 by comparing
the file sizes of the same movie file of
the same duration in different formats.

We know that sound and movie
files typically require more storage
space in the hard disk. We have also
seen that file size varies according to
format. Can’t we store more files in the
hard disk if large files can be saved in
formats that require less space? What
are the changes that occur in the file
properties when file formats are
changed? Convert a movie file from one
format to another using software and
understand the changes.

WinFF

WinFF is a software that helps us
change the formats of sound and movie
files quickly. This software, which can
convert more than one file
simultaneously, also supports a wide
range of sound and movie formats.

File Properties

Right click on the file and select
Properties. You can know the properties of
any file including size, format etc.
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Now that you have opened WinFF
window, select a movie file using  

icon. Select the details of the
format to which you want to convert
the file and the folder in which the
file is to be saved from the columns

WinFF is the GUI version of the command
line software FFmpeg which converts sound
and movie files from one format to another.
In order to open WinFF window, go to
Applications, Sound & Video and select
WinFF.

Pic. 7.5

Pic. 7.4

In certain versions of WinFF, file format does not change just by clicking
Convert tool. In such cases, open a Linux window from Preferences in the
Edit menu. See the /usr/bin/ below Terminal to run FFmpeg. Replace the terminal
name after /usr/bin/ with gnome-terminal and press OK to convert the
file format (Pic. 7.5).

below Output Details. Now click on

  and see.
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Activities

♦ You know how to convert files.
Compare different formats and find
the one with the smallest file size for
a given duration of sound and
video.

♦ Run converted files and see which
format provides the best picture
clarity.

♦ Set tune to the poems in English and
Hindi text books and sing them.

Record them using Audacity and
post them on your blog.

♦ Have you ever heard audio plays on
the radio? In such plays, the
narration is through dialogues and
background sound. Prepare an
audio play, record it using Audac-
ity, and present it in any of the
public  functions held at your
school.
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8 Computer Language

We use computers for so many
purposes including studies, games, and
communication. How do computers
understand our instructions and act
accordingly? We know that computers
work with software applications made
for specific purposes. Have you ever
wondered how these software
applications work?

For example, when you try
drawing a circle using XPaint,
computer accepts the instruction and
draws it. When it draws a circle, or while
doing any other activity, what is the
process that happens inside the
computer? Let us examine. When you
instruct the computer to draw a circle,
it is certain programmes written in
computer language that help the
computer draw the circle. Similarly,
when the computer draws any shape,

let it be a line, a triangle, or a rectangle,
there are programmes written in
computer language working in the
background.

Table 8.1 provides some of the
programmes that help us draw certain
shapes. These programmes have been
written using the computer language
Python. Find out the shapes that form
when these programmes work.
Remember working on Python codes
using gedit text editor in Class VIII.
IDLE can also be used to activate
Python codes. See the way to operative
IDLE given below.

IDLE for Activating Python Codes

Codes written in Python language
can be activated using IDLE.  IDLE is
the abbreviation of ‘Integrated

Table 8.1

Program 1 Program 2 Program 3

from turtle import* from turtle import* from turtle import*

forward (50) circle (50) dot (20, “blue”)
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ew

DeveLopment Environment’. In order
to open IDLE, select it from Program-
ming option in Applications menu.
Once IDLE opens, get File menu and
use New option to open a new file. Now
you can type and save Python codes.
The saved file can be executed by
pressing F5. If the answer involves
graphics, it appears in Turtle Graphics
window (Pic. 8.2), otherwise in Python
Shell window (Pic. 8.1).

Python codes can be executed in
the Python Shell window which appears
when IDLE opens.

For this, type in the instruction
after the Shell prompt, which is ‘>>>’,
and press Enter key (see the way

Pic. 8.1

instructions are typed in the figure).

Have you tried running all the
three programmes? Observe the way

Pic. 8.2
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instructions such as dot, forward, and
circle are used and write down their
properties. What if we replace ‘forward’
in the instruction with ‘backward’?

Let us make more shapes

Just as we draw a dot, line, or
circle, polygons can also be constructed
using Python. The programme to
construct a right polygon is given
below.

from turtle import*

pencolor(“blue”)

pensize(5)

rt(120)

fd(100)

rt(120)

fd(100)

rt(120)

fd(100)

Type in the programme and run it.
Then find out the following.

♦ What is the geometrical shape that
was made when you ran the
programme?

♦ What was the purpose of the
instruction rt(120)?

♦ What happens if rt(120) is replaced
by right(120)?

♦ Can you suggest a replacement for
the instruction fd(50)?

♦ How many times do instructions fd
and rt appear? Why?

♦ What are the uses of the instructions
pencolour (“blue”), and pensize (5)?

♦ What happens if rt (120) is replaced
by left (120)?

Note down the changes that have
to be made in the above programme if
you want to construct a square instead
of polygon

♦ Instructions fd and rt will have
to be written ___________ times

Instruction Properties/Use

dot

forward

circle

backward

Turtle Graphics

Some supporting software is needed to
construct geometrical shapes using Python
language. Turtle is one such supporting
software. Turtle Graphics forms different
shapes as an arrow mark (Turtle) moves
around the screen. For turtle instructions
to work in Python, you have to add from
turtle import* at the beginning of the
programme.

Turtle

While making geometric shapes using
Python language, you would see an arrow
mark appearing on the screen. The word
turtle is used to denote this arrow.

While using Turtle graphics in Python, if
you give the instruction Right (90), turtle
will turn 90 degrees toward right. If you
use the instruction Left (90), turtle will
turn 90 degrees leftward.
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♦ rt(120)  should be replaced by
___________

Two different ways of constructing
a right pentagon are given below.

Which of these ways is better?
Compare the two programmes and note
down the differences.

♦ By making a few changes in the
second programme, we can make
any right polygon.

♦ The number of rows in the second
programme ...........................................

..............................................................

Range

In Python language, range is an
instruction used for including a set of
values in a variable.

� If the instruction is a = range (5), the
numbers 0,1,2,3,4 will be clubbed in
variable a. Another way of framing the
instruction is a = range (0, 5).

� If you give the instruction a = range
(1,10,2), all the odd numbers below 10
would be clubbed together in variable
a. If that is the case, then what if the
instruction given is a = range
(2,10,2)?

The Instruction ‘for’

If you want any of the instruction in the
programme to be repeated, there is no need
to type it all over again. Just type in the
instruction along with ‘for’.

Count Down Clock

You must have seen the count down
clock that appears before news
bulletins in television channels. These
clocks are used in rocket launching
stations as well. Figure 8.3 shows a
programme to make a count down
clock that would show from 60 seconds
to 1 second. Prepare a count down clock
on your computer using this
programme.

 Understand the function of each of
the lines in the programme and fill up

Pic. 8.3

fd(50)
rt(72)
fd(50)
rt(72)
fd(50)
rt(72)
fd(50)
rt(72)
fd(50)
rt(72)

from turtle import*

from turtle import*

Method 1

for i in range(5):

fd(50)

rt(72)

Method 2
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Table 8.3. An easy way for
understanding the function of a line is
to drop that particular line and run the
programme without it. You can
de-activate a line by adding ‘# ’ before
that line.

Constructing Attractive Shapes

We can make attractive
geometrical shapes using computer
language. Given below are two such
shapes and the programmes to construct
them.

penup( ) Instruction

penup( ) instruction is used to move the
turtle without the lines appearing. After
giving this instruction, if you want lines
to appear, then you should use the
instruction pendown( ).

You have now run the two
programmes given above. Now try
writing the programme  for construct-
ing the geometrical shape shown below,

Geometrical Shape  Code

From turtle import*

Import time

Clear()

Circle (50)

circle(60)

circle(70)

circle(80)

circle(90)

circle(100)

from turtle import*

import time

clear()

for i in range(8):

rt(45)

circle(50)

Instruction Function

hideturtle()

showturtle()

write(s)

time.sleep(1)

clear()

range(60,0,-1)

range(1,61)

For to Turtle
appear

Table 8.3
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which has been taken from the chapter on circles in your Mathematics text book.

More Activities

Activity 1

Some shapes that can be easily drawn using Python are given below. Write
down the codes to draw them.

(A) (B)

(C) (D)

........................................................................

.......................................................................

........................................................................

.......................................................................

........................................................................

.......................................................................

........................................................................

.......................................................................

........................................................................

.......................................................................
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Activity 2

A programme to print the numbers
from 1 to 10 is given below. The result
of this code will appear in the Python
Shell window as there are no graphics
in this.

for i in range(1,11):

  print i

Do the following exercises using
the above codes.

♦ Print the odd numbers below 50

♦ Print the numbers divisible by 4 till
40

♦ Write down five more exercises of
similar nature and write their codes

Activity 3

In the following programme,
meant for finding the sum of the
numbers 1 to 10, codes have been given

wrongly. Locate the errors in the codes,
complete the programme, and do the
exercises given below.

s=0

for i in range(1,11):

s=s+i

print i

♦ Find the sum of the even numbers
below 10

♦ Find the product of all the numbers
from 1 to 5

Activity 4

Find the output of the programme
given below

n=input(“Enter a Number : “)

for i in range(1,11):

    print i,”x”,n,”=”,i*n
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9 Start, Action...

We know Charlie Chaplin and his
celebrated film ‘Modern Times’ from
our Malayalam textbook.  Charlie
Chaplin is one of the greatest film
makers in world cinema. All his films
made people laugh. However, they
were also films that depicted some of
the most compelling social and cultural
problems of their times. Most of Charlie
Chaplin films were silent ones; only the
later films have dialogues in them. It
was at a time when the very
technology of film making
was quite primitive that
Chaplin made his films, and
won over audiences across
the world.

Things have changed
now. We are living in an age
in which computers and
video cameras are very
common. We can produce
films by shooting on our
own and editing using the
computer.

We know that making
a film, documentary,
television serial, or even a
music album would need a
screenplay as a prerequisite

to its production. In the Hindi textbook
we have already seen the screenplay
‘Dheesa’. We have also prepared a
shooting script for it as a follow up
activity.

In a school in Alappuzha district,
Anu and friends, all students of Class
IX, shot scenes based on this shooting
script. They did the shooting at differ-
ent places at different times. What are
the steps we need to take to put

Pic. 9.1
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together all the sequences that Anu and
friends have shot and develop them
into a complete film?

♦ The scene sequences are to be
arranged in the same order as in the
screenplay.

♦ Delete portions that are irrelevant.

♦ Include dialogues.

♦ ..............................................................

♦ ..............................................................

All these steps are part of video
editing. There are several simple video
editing software applications that are
available today. You can edit films
yourselves using them. Let us try
making a short film out of the shooting
sequences made by Anu and friends,
using video editing software.

Let us see how these video files can
be edited using Open Shot Video
Editor.

The first step is to keep all the shots
to be edited in a single folder.

Pic. 9.2

� Open the software by selecting
Open Shot Video Editor in Sound &
Video option in the Applications
menu (Pic 9.2)

Open Shot Window

Video Editing

Video editing is the process by which we
arrange the motion pictures shot by a video
camera into meaningful narratives by
placing the sequences in the required
order and removing unnecessary shots.
There are video editing software that help
us in this. These software help us to
include dialogues, background scores,
music, titles etc., and convert the video
sequences into complete films. Open Shot
Video Editor, Kdenlive, Lives, Pitivi Video
Editor, and Kino are some of the video
editing software available on GNU/Linux.

Openshot Video Editor

This software was
designed by Jonathan
Thomas, an American
software engineer. This
is one of the simplest
video editing tools
available in free
software. The software
has been developed
using Python language. The speciality of
Open Shot Video Editor is that it supports
several video formats. To understand more
about Jonathan Thomas,

visit http//:www.openshotvideo.com

� Bring the files in the folder to the
software by selecting Import Files
from the File menu.

� Drag such files into the track in the
time line. It is in this track that we
join files or cut them. See Pic.9.4

Jonathan Thomas
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Cutting and Joining Files

Anu realised his mistake only
when he dragged his files to the track
and tried making them run.

Image clarity was poor at many
places. Worse, in some places, there
were no images at all. One needs to
rectify all these problems to come up
with a good film.

Let us help Anu and friends

� Identify the portions to be
eliminated using Play back Cursor.

� Select  (Razor tool)  from tool box
and click at the point where the
portion has to be cut (Pic.9.4).

� Use  (Arrow tool) and right click
on the video to use ‘Remove clip’
option to delete unnecessary video
clips from the track.

After avoiding all the unwanted
video clips, drag the remaining files to
track edit and arrange the clips. Run the
video from the beginning and watch.

Video Transitions

We have already used
presentation software Open Office
Impress. What are the steps involved
in making a presentation attractive?

Pic. 9.3

Pic. 9.4

Saving the file
In order to save an Open Shot project file,
select Save Project from File menu. Select
Project length and Project Profile from the
list that unfolds. Assign a project name and
click Save Project.

Video/Audio Tracks
We know that layers are used in GIMP to manipulate images. The tracks used in video
editing software are similar to these layers. Some software have dedicated tracks for audio
and video. When the software is working, the file seen on the monitor would be the one in
the top most track. If there is no file in the top most track, a file from the next track would
be displayed. Space bar is used to control play and pause video on tracks.

A film is made up of several frames. Every frame is a still photograph. When the Play
Back Cursor moves over a sequence of frames in the video track of an editing software, it
provides us the feeling of seeing a series of motion pictures.

When do we feel that an object is moving? Explore and find out.
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� Can include animation.

� Slides can be coloured.

� Transition effect can be incorporated
between slides.

� ..............................................................

� ..............................................................

Slide transition is used only when
more than one slide is used for
presentation. What are the advantages
of using transition between slides?

� The audience pay special attention
to the content in each slide.

� The audience recognise change of
slides faster.

� ..............................................................

� ..............................................................

What are the similar techniques
used in films to make changing of
scenes more impressive? Have you ever
tried to understand them?

Pic. 9.5

� Changes affected in camera
movement.

� Transition is used between
sequences.

� ..............................................................

Similar to what Anu’s group did,
you also arrange the video sequences
on the track, identify joints where you
want to provide a transition effect, and
include transition as shown in Pic. 9.5

When transition is used between two video
files, the files should be arranged in tracks
one above the other. Open transition
window, select the appropriate transition,
and drag it to the joining point of video
sequences. You can right click on
transition and click Switch Direction to
optimise transition as shown in Pic. 9.6.

When you run your video and
examine the transition, do you think it
is dragging? If you want to change its
duration, use  (Resize) Tool.
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Dissolving Images

When a scene dissolves into
another, it provides a unique visual
experience. Don’t you remember the
lesson ‘Modern Times – Anxieties of
Modern Times’ in which the ability of
dissolving shots to generate a new sense
of meaning was mentioned? See Pic. 9.7.

You have seen that transition can
be used to combine video sequences
too. Similarly video effects can also be
used for effective communication. Right
click on video files, use the effects Fade
in and Fade out, run the video and see
which are the cinematic moments in
which these could be suitable

� Fade in .................................................

� Fade out.................................................

Dialogues

You know that in films, sounds in
the background as well as dialogues are
recorded after shooting and then mixed
with visuals during editing to make the
film. We can give dialogues and
background sound to our short film too.
How to do this? If required, use
Audacity to record sound files.

Similar to the way visuals were
brought, sound tracks can also be
dragged to the track. In order to
provide appropriate background voice
to a scene in a video file, sound tracks
should be included in the track just
below that. Before recording sound, any
noise in the video file should be
removed. See the screen shot in Pic. 9.8.

Titling

You must have seen titles
appearing at the beginning and the end
of films. These include names of the
director, producer etc. We can also give
titles in our short film.

What are the titles that you want to
include in your short film?

♦ ..............................................................

♦ ..............................................................

♦ ..............................................................

Pic. 9.6

Pic 9.7

‘Modern Times’

Pic. 9.8
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♦ ..............................................................

♦ Direction : ANU

Open the title window by clicking New
Title in the Title menu. Select title
template from the box on the right hand
side and click Create New Title to name
the title. In the window that appears next,
include titles and press Apply. The titles
now appear among other sound and video
files. Now you can include them in the
track.

Open Shot Title Editor Window

Exporting Files

Now the sound and video files are
in separate tracks. We can run it and
copy it only if they are combined to
form a single file.

For this, we can export the file as
mentioned below :

� Save the project.

� Click Export Video in File menu and
provide file name, folder,
profile, and related options.

� Click Export Video.

Pic. 9.9

� Close the project window when the
exercise is over.

Open Shot Export Window

Follow Up Activities

♦ Make a short film on the folk arts of
your region using Open Shot Video
Editor.

♦ Using Audacity and Open Shot
Video Editor make a short film on
any of the following themes and
exhibit it in school. Avail the help of
your language teachers in this
venture.

� The moment that attracted you the
most in the lesson ‘The Son from
America’ in your English text
book.

� Alcohol and drug abuse among
children.

� Traditional occupations that are
fast disappearing.

� Malayalis’ obsession with luxury.

� Fast food culture.

Pic. 9.10

���
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10 Biology of Motion

Don’t you like cartoon animation
films? Just think of Tom and Jerry,
Mickey Mouse, Donald Duck, and
Mr Bean. Wouldn’t you like to see them
again and again?

You can understand the story line
just by watching the actions of Tom and
Jerry. Don’t you laugh thinking about
the naughty characters that they are?

Just as the manners and manner-
isms of Tom and and Jerry are animated
into films, we can present the
internal diffusion through plant stems
and blood circulation through human
body with the help of animation. All
these motions will get imprinted in our
minds similar to the actions of Tom and
Jerry. Won’t they?

Try to recollect possible themes
that could be presented through
animation. Remember the section on
blood groups, blood transfusion, and
the importance of blood donation that
you learned in the third chapter of
the Biology text book.

We also read in newspapers about
the rising number of road accidents and

deaths due to lack of timely medical
care. Identification of the injured
person’s blood group and the
immediate availability of matching
blood are critical in saving a life. What
are the possible life saving measures?
Shall we see an animation on related
issues?

Activate the animation called
blood transfusion in biology resources.
The animation starts with an ambulance
reaching the casualty of a hospital with
three people injured in an accident.
There are things that you also can do in
this film. See Figure 10.1.

Pic. 10.1
Source : http://nobelprize.org/educational/medicine/

landsteiner
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What are the immediate tasks to be
performed once the injured persons are
brought to the casuality?

� Test the blood samples of the
injured to identify the blood groups

� Select the right blood bags from the
given bags

� Save the persons’ lives through
blood transfusion

Now you can start the life saving
activities.

What is the order in which you
carried out the process of identifying the
blood group?

� Drew blood sample using a syringe

� Added a drop of blood into the
serum in the first test tube

� .............................................................

� .............................................................

What are the indications that we
get from the above tests in determining
the blood group of the injured person
and in pre-empting  crisis?

� Interaction between antigen and
antibody causes clotting of blood.

� .............................................................

� .............................................................

Now we have understood the
method of testing a blood sample to
identify its group.

The Secret Behind Animations

We just saw an animation which is
interesting and informative. We
understood the remarkable capability
of animations in helping us

understand different matters. How are
these animations made? Can we also
make similar animations?  Of  course
we can. Let us see how.

Animation using GCompris

Let us now try moving a car using
the GCompris tool we are familiar with.
In order to do this, first open GCompris
by selecting options from the
Applications menu in the following
order.

Applications → Education →
Educational Suite GCompris

 See the teddy bear standing with
a ball (Figure 10.2). Click on the teddy
bear and the next window opens. You
can see the image of a film in the new
window (Figure 10.3). If you click on
that,  several tools and colours will

Pic. 10.2

Pic. 10.3
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appear. Select a car of your choice from
there. Place it on the canvas that you
have selected and activate different
tools. Observe the changes that
happen to the car.

Now let us make the car move.
Click on the camera in the tool box and
then move the car a little forward.
Repeat these steps. Do not forget to

convert each image into a frame using
the camera tool. For this, every time the
car is moved forward, camera has to be
clicked. Move the car further forward
and repeat the steps. You can make the
movement of the car more lively by
adding road, trees etc. Now click on the
scene board icon in the tool box. How
do you like this movement of the car?
How could the car move like this? We
created a frame in each of the camera
clicks. When we clicked on the scene
board, the frames appeared one after
another in a sequence, that too very
quickly. This is what made us feel that
the car was moving. These types of
frame sequences that appear and
disappear fast is the the secret behind
animations.

Open a canvas, place a picture on
it, click each tool in the tool box and then
on the selected picture, and observe.
Note down the use of each of the tools.

The Invisible World of Blood

Observe blood cells by activating
the animation called ‘Blood Cell’ in
animation resources. What are the
preparations to be made for observing
blood cells?

Save For saving
Camera .....................................

..................... .....................................

..................... .....................................

..................... .....................................

Move Tool For changing
posistions

..................... .....................................

..................... .....................................

..................... .....................................

Pic. 10.7

Pic. 10.4

Pic. 10.5

Pic. 10.6
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Pic. 10.8

� Arrange glass slides, cover slips,
needle, ........................

� Set up the microscope .......................

How  do different blood cells vary
in their shape, structure, and
functions?

� Cell nucleus is seen in red blood
cells.

� The nuclei of white blood
cells.....................................

� Size:

Red blood cells ....................................

White blood cells ................................

What about their count? ....................

Even though blood cells are
different in their structure and count,
they work together in providing
immunity to the human body and in
transporting oxygen, glucose etc.,
through the body.

Through the above activities, we
have understood blood cells and blood

transfusion. Now let us see blood
circulation, the structure of the heart,
and the working of heart valves.

In biology resources, watch the
animations that show blood circulation,
working of the heart valves, digestion
process, the structure and working of
the lungs. Then prepare notes in the fol-
lowing format on the structure and
working of the heart, lungs, heart
valves, and blood circulation. You
already know how to use Open Office
Word Processor for this.

Heart.

The four chambers of different sizes.

The rhythmic expansion and contraction
of heart chambers.

...................................................................

...................................................................

Lungs

...................................................................

Heart valves

...................................................................

Blood circulation

...................................................................

Internal Diffusion in Plants

We know life depends on plants.
Plants provide us food and even the
oxygen to breathe. In order to produce
food, plants absorb water and minerals
from the earth. It is estimated that a large
tree dispenses around 1500 litres of
water into the atmosphere per day
through transpiration. Let us try
observing this magic of the plants.
Activate the animation called ‘Internal
Diffusion in Plants’ in Biology
Resources. Please do not forget to note
down your observations.
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Several free software animation tools are
available now. Draw SWF, Blender,
Luciole, Pencil are examples.

Blender helps us make 3D animation. An
animation film called Bick Buck Bunny is
included in resources. This film, which
gained global recognition, is testimony to
the unlimited potential of free and open
software.

Draw SWF is an animation tool meant to
facilitate small movements

Pic. 10.9
Source : http://www.kscience.co.uk/animation/

water_movement.htmm

A Biological Magic in the
Classroom

We have seen several animations that
explain biological processes. Now let us try
observing a few micro organisms. How
fascinating it would be to magnify and see
micro organisms such as amoeba,

Paramecium, and hydra, commonly
present in the water bodies around us.

For this, we can convert the
microscope available in the school
laboratory into a USB Microscope that can
be connected to a computer.

First watch the video on USB
Microscope in Biological Resources
carefully.

This is a group activity. The USB
Microscope has to be  connected to a laptop
computer and projector with the help of
your teacher.  In addition to watching
micro organisms present in paddy fields and
other wet lands, we can use the USB
Microscope to see sections of flowers, leaves,
and stems of plants, as well as observe the
tiny body parts of ants, mosquitoes etc.
Complete the various observations indicated
in the section using USB Microscope and
note them down in your science diary. See
Table 1.

The micro organisms that you observed Their Propertie

................................................... ...............................................

................................................... ...............................................

................................................... ...............................................

Table. 10.1
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3D Pictures

Have you heard of 3D films that can
be viewed only with the help of special
eye glasses? However, we can see some
of the 3D pictures in the biology text
book clearly without eyeglasses. These
3D pictures are called Anaglyph. The
principle is to create stereoscopic 3D
effect by simultaneously employing
two cameras placed in such a way that
the distance between them is equal to
the distance between our eyes. These
types of pictures are given in biology
resources. But we need special eye
glasses to see them. We can in fact make
these eye glasses on our own. The
method of making them is also given in
the resources. Make your own glasses
to see the pictures.

Pic. 10.10

Pic. 10.11
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11 Magic of Physical Sciences

PhET Circuit Construction Kit

Open PhET from the School
Resource menu in Applications. Click
Play with sims and Physics in that
order. Select Circuit construction kit.
Now you can open PhET  Circuit
construction kit from the down load
window that opens while pressing Run
Now.

All of us know the principle of elec-
tric bulbs that provide us light in the
night. How do we connect a bulb to an
electric source using a circuit? What all
do we need to construct an electric cir-
cuit for lighting a bulb? Prepare a list
of materials.

� Conductor cable

� Bulb

� ..............................................................

� ..............................................................

� ..............................................................

� ..............................................................

� ..............................................................

Conducting a practical exercise to
construct a circuit by buying all the re-
quired parts is not so easy. There are
simple software applications that help
us learn how to make circuits through
simulation.

Activity 1

The main window of the  Circuit
construction kit is shown in Figure 11.1.
In this window, menu bar is given on

Pic. 11.1



Information & Communication Technology

82 �

Pic. 11.2

top and tools on the right. From the
tools, drag bulb, wire, and battery to
the window. Connect these using a wire
as shown in Pic. 11.2. The bulb lights
up. Use the options ‘lifelike’ and
‘schematic’ in the menu bar. Observe
the differences.

Activity 2

Open  Circuit construction kit and
drag down battery, bulb, and resistor
into the window. Place mouse pointer
on each piece, right click and see. What
are the facilities available? Tabulate
these.

Changes in Circuit

Can we add new components into
the circuit by clicking the right button
of the mouse on the junctions in the
circuit and selecting Split Junction? Try
out and see.

Pic. 11.3

Activity 3

Open  Circuit construction kit and
construct a circuit similar to the one in
Figure 11.4. Click and  drag Non
contract ammeter from the tool bar and
bring them into contact with the wire.
You can increase and decrease the
voltage by clicking on the battery icon.
By observing the brightness of the bulb
and checking the corresponding
ammeter reading, answer the following
questions.

� What happened to the electric current
in the circuit when the battery
voltage was increased?

� What happened when voltage was
reduced?

Note down the relation between
current and voltage in the circuit.

Now connect a 10 Ohm resistor in
the circuit. Observe the change in
current and brightness of the bulb. You
can increase and decrease resistance
using Change resistance option by
right-clicking the resistor.

Find out the change in the current
when the resistance in the circuit is
increased and decreased.  Prepare
observation notes based on your
findings.

Pic. 11.4
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No. Voltage (V)      Current (I) V/I

1

2

3

4

5

Table 11.1

Pic. 11.5

Fill up Table 11.1 by changing the
circuit voltage to 12V, 15V etc., and
measuring the corresponding values of
current. Find out the ratio between
voltage and current. What is your
finding on the relation between circuit
current and voltage?

Activity 4

Construct a circuit using two bulbs
of different power rating (resistance),
battery, wire, and switch as shown in
Figure 11.5.

Find answers to the following
questions by operating the circuit. Also
note down your findings on these types
of circuits.

� How much current passes through
each bulb?

� Is the voltage the same between the
two bulbs? Examine this by dragging
volt meter from the tool bar to the
window.

� Remove one of the bulbs from the
circuit after selecting it by right-
clicking. Does the circuit still work?

Activity 5

Construct a circuit as given in
Figure 11.6 using the same components
used in Exercise 4.

Do the following experiments and
tabulate your observations. Find out the
current through each bulb and also the
circuit current. Are both the bulbs at the
same voltage level? Right click on one
of the bulbs and remove it from the
 circuit. Does the circuit still work?

Pic. 11.6
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What are the differences between
the two circuits that we constructed
above? You must have seen illumina-
tion displays on festival grounds. Find
out how the bulbs are connected in a
circuit there. Is it in the same way as the
circuits for our houses and large build-
ings are made? What is the difference?
Can you compare those circuits with the
ones that we constructed in the above
activities? Find out.

Follow Up Activities

� The current in a circuit using a bulb,
resistor (10 Ohm), and battery (9V)
is 0.45 ampere. What are the changes
to be made in battery voltage and
resistor to increase the circuit current
to 1 ampere?

� Construct a circuit by connecting
10 Ohm, 15 Ohm, and 20 Ohm
resistors in series connecting them
with a 9V battery. What will be the
circuit current? What is the current
level corresponding to the battery
voltage of 12V? What will be the
circuit current if you increase the
resistance offered by the same
resistors to 15 Ohm, 20 Ohm, and 25
Ohm?

From Charcoal to Glittering
Diamonds

You have understood that carbon

Saving a Circuit

The circuits that are constructed
using Circuit construction kit can be saved
on the computer. For this you can use the
save option in the Circuit menu shown at
the right hand top corner of the main
window. And you can open a saved file by
using the Load button given in the same
menu

is an element that exists in various forms
ranging from charcoal to diamond. In
what all forms have you seen carbon?
Each form of carbon has different
properties. Isn’t it surprising that it is
the same element that makes charcoal,
pencil lead, and diamond? Have you
ever thought of the reason for this
diversity? We can understand the secret
behind it by examining the atomic
structures of these materials.

But we cannot see the atomic
structure in materials directly. Now we
have computer tools to help us observe
them. You have learned how to make
models of simple molecules using
computer software in lower classes.
What were the software applications
that helped you in making them? What
were the molecular models that you had
made?

� Water

� ..............................................................

� ..............................................................

� ..............................................................

All these were simple molecules.
There are also complex molecules
formed by several atoms. Fullerin, yet
another isotope of carbon, is one such
complex molecule.

Pic. 11.7
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Being extremely complex, it is not
easy to understand Fullerin’s atomic
structure. However, now it is easy to
observe the molecular models and

RasMol

RasMol is a software that helps us
display complex molecular models. It can
display files with extension .pdb (protein
data bank) using RasMol.

Among the two windows that appear
while opening the software, the black one
is for graphics and the white one is
terminal.

Type in the name and location of the
file to be opened in the graphics window
and press enter key. You can select the
appropriate molecule from the display
menu and see. You can also observe the
molecular model that appears in the
window form different angles by shifting
and rotating it using mouse. We can get
the number of atoms in the molecule by
typing in ‘select carbon’ in the terminal
window and pressing enter key. The colour
of selected atoms can be changed by
pressing enter key after typing ‘colour
yellow’, for instance.

Pic. 11.8

understand the peculiarities of their
atomic structure using software.
RasMol is a software that helps us here.

Activity 6

Display the atomic structure of
Fullerin molecule. Move the molecule
around and observe the peculiarities of
its atomic structure. Estimate the num-
ber of atoms by giving the instruction
‘select carbon’ in Terminal window.
Then colour the atoms. Observe the
molecule in models such as Sticks,
Spacefill, Ball & Stick.

Activity 7

Observe the atomic structures of
diamond, graphite, sugar, and glucose
using RasMol software.

Discuss their properties based on
their atomic structures.

Making Molecular Models

Similar to what you have done in
Class VIII, prepare the molecular mod-
els of C3H8, C2H2, C2H4, C3H6 etc.
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from Wikipedia for your Malayalam
lessons?

There are other wiki initiatives led
by the Wiki Foundation which we can
use for information collection. We can
also enrich these through our own
contributions.

1. Wikipedia – An ever expanding free
online encyclopedia which has 130
lakh articles in 266 languages.

2. Wiki Dictionary – A free online
multi-language dictionary contain-
ing definitions, etymology, pronun-
ciation, model quotations, syn-
onyms, antonyms, and translations.

3. Wiki Books – A collection of books
on various subjects.

4. Wiki Quotes – A collection of prov-
erbs, puzzles, movies, texts, themes,
idioms and axioms, legal dictionary,
quotes, folklore etc.

5. Wiki Species – Database on flora
and fauna.

6. Wiki News – A free news centre.

7. Meta Wiki – A forum for coordina-
tion of wiki initiatives.

8. Wiki Commons – A common pool
resource of wiki files.

9. Wiki University – The wiki centre
of learning.

School Wiki (www.schoolwiki.in)
is a school encyclopedia being created
under the leadership of IT@School in
collaboration with all the schools in the
State. You can see information on your
school too on that. Please check them.
If you find the information available on
your school to be incomplete, you can
add more relevant information with the
help of your teachers.

Post your creations on your blog,
say a story, a poem, or a simple
travelogue.

Activity 2

Sharing Ideas on Blogs

Once you post your content on the
blog, share the URL of the blog with
friends. Also get the URLs of their blogs.

Note down the URLs of your
friends’ blogs below:

http://.......................................................

http://.......................................................

Comments on the Blog

Posting your opinion on the posts
on blogs is called ‘commenting’. Links
for reading the comments already made
as well as for posting new comments
are provided below every post. You can
click on the link and post your comment
in the window that opens. Once you
post a comment, you can include your
user name and password and publish
it.

Won’t you try commenting on the
writings of your friends? You should
try improving your creativity by
sharing creations on blogs and
commenting on them.

Follow up Activities

� Create a blog to publish your
learning experiences relating to your
school

� Create a blog including the stories,
poems, and essays that you and
your friends have written.

Wiki

You have familiarised yourselves
with Wikipedia, the free online
encyclopedia in Class VIII. Don’t you
remember collecting information on
Sree Narayana Guru and Aiyankali
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Does your school have hand
written magazines that the students
prepare? Have they ever carried your
creative work? Don’t you get
inexplicable satisfaction when you see
others reading what you have written?

Suppose you have published your
writing in print media. More people are
likely to read it compared to the
number of people who may see a
handwritten magazine. However, there
are several hurdles to cross before you
get published.  Can you imagine what
are those hurdles?

� You need a publisher

� The editor of the publication has to
examine and approve your work.

� It has to be printed

�  .................................................................

�  .................................................................

The advent of Internet opened the
possibility of a new avenue for
publications. Anybody can publish their

work as web pages whenever they want
to.  Several people can read it at the same
time and send feedback too. You might
have read about ‘blog’ which makes this
possible, in the fourth unit of your
Malayalam text book.

Have you seen blogs? Visit
different blogs with the help of your
teachers.

Blog is an abbreviation of web log.
It was John Barger who first used the
coinage web log in 1977. Peter Merholz
made the abbreviation ‘blog’ from web
log in 1999.

Creating Blog

Shall we try making a blog?
Tutorials that help us make a blog are
available on Internet in all the major
languages. If you can locate such
tutorials with the help of your teachers,
creating a blog would become easier.

Some preparations are needed
before you get on to making your blog.

Blog as a Medium of Expression12
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Activity 1

Try creating a blog using any of the
free blog service providers such as
blogger.com, wordpress.com,
rediff.com, and msn.com

Posting Information on Blog

It is not enough to create a blog; we
have to post our creations on it. Every
blog has a window for including new
pieces of writing, pictures, or any other
form of information. You can write in
the language of your choice. If we
compare a blog with a book, posts in a
blog are akin to chapters in a book.

Posts can be of any type – stories,
poems, pictures, paintings. Image files,
voice files, video files etc., can be part
of your posts. You can add more
content or delete some of the existing
content when ever you want.

Think over it and fill up the following.

� What is your email ID?

..............................................................

� What pen name would you use on your
blog? (Display Name):

..............................................................

� Title for the blog (Blog Title) :

..............................................................

� Address of the Blog (Blog URL) :

http://.....................................................

You can create your own blog. It is
as simple as creating an email account.
There are three steps in creating a blog.

� Creating an account

� Naming your blog

� Choosing a starter template

Pic. 12.1
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in the window that opens. Once you
post a comment, you can include your
user name and password and publish
it.

Won’t you try commenting on the
writings of your friends? You should
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sharing creations on blogs and
commenting on them.
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� Create a blog to publish your
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� Create a blog including the stories,
poems, and essays that you and
your friends have written.
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You have familiarised yourselves
with Wikipedia, the free online
encyclopedia in Class VIII. Don’t you
remember collecting information on
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Malayalam wikipedia already has
about 15,000 articles on various
subjects. It is ever expanding too.
Enriching and strengthening this free
online information bank would be
useful to the future generations. Won’t
you also join hands in contributing to
such meaningful efforts?

Follow up Activities

Add an article on a subject of your
choice in Malayalam wikipedia after
collecting all the relevant information.
Please take care to ensure precision and
authenticity of the information that you
collect.

Searching for Information

You learned the ways to search for
information on the Internet in Class VIII.
Do not assume that all the information
that you get are correct. What Internet
offers is a pool of correct and incorrect
information, as well as facts and
fallacies. Therefore it is important to
develop the skills to judge the
correctness of information.

Pic. 12.2

What is Wiki?

Wikis are webpages that allow
readers to effect corrections, additions,
and deletions. Any lay person can
handle wiki pages using simple tags.
Wikipedia is the largest member of the
wiki family.

A software programmer called
Ward Cunnigham is the father of wiki.
It was Jimmy Wales who initiated
wikipedia on 15 January 2001 using
wiki software.

There is a facility in Malayalam
wikipedia which allows you to easily
type in your queries and search for
information in Malayalam. Can you
locate this?

There are ‘how to use’ tips
provided on the left hand margin of the
main page in wikipedia. Open in the
order – Guide, Help. You can also see
links that allow you to post new articles
as well as to improve the existing ones
in wiki.
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Internet – Use and Abuse

You are already familiar with
Internet. It is with the help of the global
network of computers that people
collect and share information on a wide
range of topics today. People use
computers and Internet in every walk
of life now. Large pools of information
and knowledge are just a finger tip
away for us. No wonder our age is
called the computer era.

This technology, no doubt, has
influenced human life in depth, and has
contributed to several achievements of
the humankind. However, the same
technology is also being abused to a
large extent. Internet is being misused
for cheating and other criminal
activities. This is akin to the way
dynamite, an invention by Alfred
Nobel meant to benefit the world in

We have to adopt appropriate
searching methods to find the exact
information that we need quickly from
the information deluge on the Internet.
For instance, suppose you want to look
for information on ‘Green House Effect’
that you learn in Social Sciences. Type
in  ‘define: Green House Effect’ in search
box. Then search without the word ‘
define’. See the difference. Search for
information on other themes in Social
Sciences such as the Structure of the
Atmosphere, Global Warming, Ozone
Depletion, Web Search, Image Search,
and News Search. Just like you used ‘
define’, try using symbols such as ‘+’,
‘-’,  ’’ ‘’ etc., and words such as site:,
inurl:, and location and see the differ-
ences that these can make to your search.
The tips that you can get by looking for
‘search tips’ in search engines help you
do effective exploration of information
on Internet.

Pic. 12.3
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processes, stealing or destroying
databases, or even destroying the
computers themselves.

Cracking : Cracking is illegally
entering a computer or a network and
using or destroying its databases.

Hacking which is about examining
software applications and operating
systems in depth and modifying them to
improve their performance, is often
described wrongly as cracking.

Phishing : Phishing is extracting
information on passwords, credit card
related information, and other secured
data by misguiding individuals
through malicious actions.

Cyber Squatting : It is the action of
creating and displaying unauthorised
websites posing them as official or
authentic.

many ways, was used in wars to kill
and destroy. It is shocking to realise that
a large share of crimes that happen the
world over have something to do with
computers, Internet, and mobile
phones. These are called cyber crimes
in general.

Cyber Crimes : All actions that employ
modern information and communica-
tion technologies such as computers,
mobile phones, and Internet that are
detrimental to people and communities
in any way can be considered cyber
crimes.

Computer virus : You are familiar with
viruses that attack human and animal
bodies by entering them and
multiplying fast. Similarly, computer
viruses are programs that can
multiply themselves inside a computer
thus affecting its speed, hindering

Cyber Law in India

India got its first cyber law on 17 October 2000 through IT Act 2000. This was
amended on 27 October 2009. This Act deals with a wide range of issues  from those
relating to e-governance, digital signatures for authenticating digital documents,
security of strategic databases etc., to the terms for prosecution in case of cyber crimes.
This cyber law is available in the section titled ‘Cyber Lad & Security’ in the official web
site of the central IT department www.mit.gov.in.
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Pornography : Pornography is the
display and spreading of obscene
information and pictures.

Cyber Terrorism : These include
activities that challenge the sovereignty,
integrity, and security of nation states
using cyber technologies and tools.

Invasive actions that infringe on an

While using Internet

The developments of blogs, proliferation of
social networking sites (orkut, face book, my
space), evolution of wikis, podcasting etc.,
and development of tools such as web 2.0
which allow better interaction and
enhanced cooperation remind us of the need
to exercise care and discretion in their use.

It is the most important to be discreet in
exposing personal information to these
networks. It is better to create and use a
dedicated e-mail ID, which is different from
your regular use ID for these sites.
Information on pass words as well as on
credit cards and other instruments used by
elders typically gets disclosed through your
responses to mails that appear authentic.
Therefore stay away from providing such
information under any circumstances.

When you use these Internet services, take
care not to disclose personal
information to unknown people. Using
content filtering packages and adopting use
restrictions limiting browsing to child
friendly pages are as important as using anti
virus packages. It is better to set browser
options such as ‘Content Setting’ and ‘Safe
Search’ for children.

On social networking sites distinguish
between information for private viewing
and that for public viewing. Provide
personal information only accordingly.

Internet services are usually used for online
chating and defamation. Beware of the
requests for personal meetings from friends
whom you have linked through
social networking sites or groups.
Accepting such invitations could be your
pass word to trouble.

Do not respond to spam mails at all. If the
perpetrators of such mails realise that your
e-mail ID is active as in responding to them,
they would continue to bother you.
Activate the spam guard available especially
in e-mail services.

It is not enough to be careful as a
receiver of information. It is important to
exercise restraint and caution while
sending information as well (over e-mails,
chats, social networking sites, SMS etc.).
Stay away from sending misleading,
demeaning, or obscene information over
these media. Be careful while forwarding
messages too. Think twice before forward-
ing a mail; think whether they would cause
inconvenience to the receiver.

Mails that approach you with claims such
as somebody wants to donate a huge sum
of money to you, or that you have won a
bumper prize in a lottery etc., are intended
to extract information on your financial
transactions including bank and credit
card details. Do not respond to such mails.

individual’s privacy, as well as
exchanging or spreading messages,
images, or information with an
intention to defame individuals using
information and communication
technologies also belong to the
category of cyber crimes. Many
countries have passed special laws to
prevent and mitigate cyber crimes.
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